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1. OBJETIVO

Establecer los lineamientos y procedimientos para el manejo operativo del cromatografo de gases Agilent
7890B acoplado al detector selectivo de masas de triple cuadrupolo Agilent 7000D que permitan la puesta en
funcionamiento del equipo.

2. ALCANCE

Este instructivo inicia con el alistamiento y encendido del equipo, se presenta de manera detallada
informaciéon que permite realizar el acondicionamiento, optimizacién, calibracion (autotune), creacion de
métodos en el cromatégrafo de gases Agilent 7890B acoplado al detector selectivo de masas de triple
cuadrupolo Agilent 7000D y posterior operacion del equipo para la determinacién de los compuestos de
interés.

3. DEFINICIONES

e Inyector: modulo de introduccion de la muestra al sistema cromatografico utilizando una jeringa. La
muestra inyectada es vaporizada y conducida a la columna capilar por medio del gas de arrastre.

e Cromatografia de gases: método de separacién de mezclas complejas a través de la reparticion de los
analitos entre la fase estacionaria y la fase movil (gas inerte).

o  Espectrometria de masas: es una técnica analitica mediante la cual atomos o moléculas son ionizados y
separados por su relacion masalcarga (m/z).

e  Cuadrupolo: analizador de masas que consiste en cuatro barras paralelas que utilizan las trayectorias en
campos eléctricos oscilantes para separar los iones de acuerdo con su relacion m/z.

o  (Celda de colisiones: es un hexapolo de alta presién con una aceleracién lineal ajustada para optimizar la
fragmentacion de los iones utilizando un gas inerte que puede ser nitrégeno o argon.

e  Columna: tubo capilar de silice fundida recubierto con poliamida y fase estacionaria apolar en donde
ocurre la separacién de los compuestos.

e Tuning: proceso de ajuste que optimiza la eficiencia del espectrdmetro de masas. El objetivo es
maximizar la sensibilidad manteniendo una resolucion aceptable, asegura la asignacion de masas
precisas y proporciona las abundancias relativas deseadas en el espectro.

e  Autotune: ajuste automatico de los parametros del espectrometro de masas para el compuesto de
calibracién, en este caso, perfluorotributilamina. Cuando se ejecuta el autotune, un ajuste y calibracion
son realizadas automaticamente con los parametros cargados en el archivo del tune.

4. ASPECTOS DE SEGURIDAD Y SALUD EN EL TRABAJO

Procedimientos operativos 0 practicas no realizadas de forma correcta podrian resultar en dafio del
instrumento o pérdida de datos importantes. No proceda mas alla de un aviso de precaucion o peligro hasta
que las condiciones indicadas se entiendan y sean cumplidas. Realizar el mantenimiento y verificacion del
equipo con los elementos de proteccidn personal evitando introducir contaminantes en el sistema que afecten
el funcionamiento del instrumento.
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5.

EQUIPOS, REACTIVOS Y MATERIALES

Los componentes basicos del instrumento son:

Lo

Sistema de vacio.

Interface GC / MS.

Fuente de iones.

Electronica.

Cromatégrafo de gases (GC) serie 7890B.

Detector Selectivo de masas (MSD), Agilent Triple Quad serie 7000D.

Dos analizadores de masas cuadrupolares con calentamiento independiente.
Hexapolo simple, camara de colisiones.

Muestreador automético de liquidos Agilent 7693.

Fuente de gas.

LIMITACIONES E INTERFERENCIAS

Se requiere que el instrumento sea operado por un profesional con experiencia relacionada en la técnica
de cromatografia de gases acoplada a detectores selectivos de masas.

El inyector, horno, detector o bomba mecanica pueden estar lo suficientemente calientes como para
causar quemaduras. Enfrie las zonas a una temperatura de manipulacion segura antes de continuar.

No encender el horno a altas temperaturas hasta asegurarse que el gas de arrastre esta corriendo por el
sistema. La temperatura del horno y de la interface nunca debe estar por encima de la temperatura
maxima permitida de la columna.

Verificar la presion en el cilindro de helio. La valvula del cilindro debe estar abierta y la presiéon mayor de
500 psi, presiones menores pueden introducir interferencias y contaminantes en el sistema. Si la presion
es menor se debe cambiar el cilindro. Los gases (He y N») deben ser de calidad cromatogréafica, se
recomienda que la pureza del gas sea al menos grado 5.0 (99.9995%).

Si el espectrometro de masas esta conectado a una fuente de alimentacion, incluso si el interruptor de
alimentacion esta apagado, existen tensiones potencialmente peligrosas, por tanto es recomendable que
esté conectado a un sistema de alimentacion ininterrumpida (UPS, Uninterruptible Power Supply, por
sus siglas en inglés) que permita proteger el equipo en caso de fallas generados por picos o caidas de
tension o interrupcion de la energia eléctrica. El voltaje de operacion es de 120VAC + 10% o 220VAC +
10%.

Temperatura ambiente recomendable para la operacion del equipo debe estar en el intervalo entre 13 a
35 °C y la humedad relativa entre 25 — 95 %. Ambientes demasiado secos (por debajo del 25%) de
humedad relativa pueden generar errores o fallas en el equipo. De la misma forma, ambientes
demasiado humedos pueden producir condensacién sobre los componentes del instrumento.
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7. CONTROL Y ASEGURAMIENTO DE LA CALIDAD

El aseguramiento de la calidad del funcionamiento del equipo puede ser verificado a través de las
calibraciones y ajustes realizados por el sistema: check air and water, autotune y check tune. Debe realizarse
el cambio periodico de consumibles que se desgasten y el mantenimiento preventivo del equipo.

8. DESARROLLO
8.1. Principio del método

La cromatografia de gases (GC) es una técnica de separacion en la que los componentes de una mezcla se
reparten entre dos fases: una fase estacionaria, con una grande area superficial y, una fase mévil, que es un
gas inerte. En esta técnica la muestra se vaporiza y es transportada por la fase mévil conocida como gas de
arrastre (usualmente helio, hidrégeno o nitrégeno) a través de la columna que contiene la fase estacionaria.
Los componentes de la mezcla o analitos son separados con base en sus presiones de vapor relativas y su
afinidad por la fase estacionaria y posteriormente llegan al detector, cuja respuesta es mostrada en el monitor
(MILLER & McNAIR, 1997).

La espectrometria de masas (MS) es una técnica que permite estudiar las masas de atomos, moléculas o
fragmentos de moléculas. El analisis por espectrometria de masas permite obtener espectros de masas, en el
que las moléculas gaseosas se ionizan, los iones se aceleran en un campo eléctrico y posteriormente se
separan segun su relacion masa/carga (m/z). En el caso en que las cargas sean igual a +1, la relacién m/z
correspondera numéricamente a la masa molecular, o masa de los fragmentos (HARRIS, 2010).

La cromatografia de gases acoplada a la espectrometria de masas (GC/MS, gas chromatography coupled
mass spectrometry, por sus siglas en inglés) constituye una de las técnicas de mayor interés para el analisis
de mezclas complejas por su capacidad de separar, identificar y cuantificar los analitos. Para que una
sustancia pueda ser analizada por GC/MS debe ser suficientemente volatil y térmicamente estable.

Un espectrémetro de masas unido al cromatdgrafo de gases es conocido como detector de masas o detector
selectivo de masas (MSD, Mass Selective Detector, por sus siglas en inglés). La espectrometria de masas se
basa en el andlisis iones que se mueven a través de vacio. En GC-MSD, generalmente la ionizacién de la
muestra ocurre en la camara de ionizacion o fuente de iones mediante la técnica clésica de ionizacion
electrénica o impacto de electrones (El, electron ionization or electron impact), también puede ser utilizada la
ionizacion quimica (Cl, chemical ionization).

En la El un haz de electrones producido por un filamento de tungsteno cargado con alta energia bombardea a
las moléculas retirando un electrén de la molécula en fase vapor generando pérdida de la neutralidad. De esta
forma, son producidos iones positivos, iones negativos y especies neutras. Los iones positivos se dirigen al
analizador por repulsion electrostatica, los deméas son expulsados a través del sistema de vacio. Los iones
positivos se analizan por un analizador de masa que controla el movimiento de los iones a medida que viajan
al detector para convertirse en sefiales reales. En la El los electrones tienen tanta energia (70eV) que se
producen muchos iones fragmento, producto de la energia excesiva que hace que la molécula se fragmente.

Uno de los analizadores de masas mas usados en el acople GC-MSD es el analizador cuadrupolar, un
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analizador de barrido conocido como cuadrupolo o filtro de masas. Un cuadrupolo esta formado por cuatro
barras solidas paralelas en la direccion de un haz de iones. Un voltaje de corriente continua e una
radiofrecuencia son aplicados a las barras, generando un campo electrostatico oscilante en la regién entre las
barras (STASHENKO & MARTINEZ, 2010).

Dependiendo de la razon entre la amplitud de la radiofrecuencia e el voltaje de la corriente continua, los iones
adquieren una oscilacion en ese campo electrostatico. De esta forma los iones son separados en relacién con
la estabilidad de sus trayectorias en el campo eléctrico formado. Las trayectorias serdn dependientes del
campo eléctrico producido de modo que apenas los iones de una particular relacion m/z tendran una
trayectoria estable e llegaran al detector. Los demas valores de m/z tendran trayectorias inestables y podrian
colisionar o escapar de la regién central del cuadrupolo, no llegando al detector. Debido a este proceso, es
comun decir que el analizador de masas cuadrupolar es un filtro de masas.

Una de las caracteristicas mas interesantes del MSD es su capacidad para funcionar como un detector
universal, selectivo o especifico. En la actualidad, la utilizacion de mas de un analizador en una configuracién
multidimensional lo transforma en un detector especifico, esta configuracion también es conocida como
tandem (MS/MS). Para realizar un analisis de masas en tandem en el espacio, es necesario tener mdltiples
analizadores conectados en serie. Uno de las configuraciones mas comunes de espectrometros de masas en
tandem es el triple cuadrupolo (QQQ o QqQ). Los componentes basicos del GC-QqQ consisten en una fuente
de ionizacién, un cuadrupolo (Q1), una camara de colisiones (Q2), un segundo cuadrupolo (Q3) y un detector.

Un modo de andlisis méas utilizado en el QqQ es el monitoreo de reaccion multiple (MRM, Multiple Reaction
Monitoring). En este modo de adquisicion, la fuente de ionizacion produce los iones, el Q1 es el primer filtro
de masas que permite la seleccionar el ion de interés, llamados de iones precursores (también conocidos
como iones padre). En la camara o celda de colisiones (Q2) ocurre la fragmentacion del ion precursor. Un
gas de colision como el nitrgeno es introducido produciendo la fragmentacion del ion precursor seleccionado
generando los iones producto (conocidos como iones hijo). EI Q3, actua como un segundo cuadrupolo
filtrando el paso de los iones productos seleccionado para permitir que lleguen al detector. Note que es poco
probable que haya otro compuesto con las mismas transiciones de ion producto e ion precursor que las del
analito. El QqQ permite analizar especificamente los iones de interés, eliminando interferencias y
disminuyendo el ruido en la medicion. De esta forma se obtiene mejor sensibilidad y selectividad
(STASHENKO & MARTINEZ, 2010).

Este instructivo describe el procedimiento para el manejo adecuado en rutina del equipo. El equipo consta de
un espectrémetro de masas (MS) de triple cuadrupolo Agilent serie 7000D, cromatégrafo de gases (GC)
Agilent GC serie 7890B, muestreador automatico de liquidos (ALS, Automatic Liquid Sampler, por sus siglas
en inglés) serie 7643 con bandeja para 150 viales (véase Figura 1), conectados a un computador con el
software para manejo y adquisicion de datos MassHunter Workstation Version B.07.05. El equipo también
puede ser operado desde el panel de control de operaciones del GC. Dentro del paquete del software incluye
el Data Acquisition, Quantitative Analysis y Qualitative Analysis.

Desde el software MassHunter Data Acquisition se puede: iniciar y detener el instrumento; revisar la
configuracién del equipo en tiempo real; crear, editar, ejecutar, cargar un método; crear, editar, comprobar,
ejecutar una secuencia, evaluar los parametros del MS, supervisar las condiciones en tiempo real de los
parametros del instrumento. Presione F1, use el menu Help o el boton Help en cualquier cuadro de dialogo
para acceder a Help en linea para el software MassHunter Data Acquisition.




Ca

Instituto de Hidrologla,
i

4
IDEAM Yosmese e

INSTRUCTIVO DE MANEJO DEL
CROMATOGRAFO DE GASES ACOPLADO AL
DETECTOR SELECTIVO DE MASAS DE TRIPLE
CUADRUPOLO AGILENT GC 7890B/QqQ 7000D

Cadigo: M-S-LC-1013

Versioén: 01

Fecha: 14/12/2017

Pagina: 5 de 54

ALS

Cromatdgrafo de gases
GC serie 7890B

Triple cuadrupolo MS
serie 7000D

Panel de operaciones
(pantalla, indicadores

Interruptor de =
alimentacién de MS

| | %
Interruptor de [
alimentacion del GC |____Bandeja

Figura 1. Sistema de triple cuadrupolo Agilent 7000D, con cromatdgrafo de gases Agilent 7890B y muestreador

automatico de liquidos ALS.

El sistema cuenta con una coleccion de manuales, videos, guias de familiarizacion, aplicaciones de usuario y
herramientas de desarrollo de métodos en idioma inglés para consultarlos en caso de dudas. Los archivos se

encuentran en medios magnéticos en:

* Agilent GC y GC / MS Manuales de usuario y herramientas DVD set.
* Agilent GC | MS Software Informacién y manuales memory stick.
También es posible ingresar desde los accesos directos disponibles en el DESKTOP del computador (véase

Figura 2).

"5‘ w “-'v l‘l;—'m ILVE [E
MARADAE
@

Agilent Technologies

MANUALES ‘

Figura 2. Ubicacion de los accesos directos a los manuales de usuario.
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8.2. Encendido del equipo

Antes de proceder a encender el equipo se deben verificar las condiciones basicas del sistema para que sea
puesto en funcionamiento evitando dafios o problemas.

8.2.1. Abra las vélvulas de los cilindros de gases de helio (He) y nitrogeno (N2), grado de pureza 5.0
(99.9995%) ubicados en el cuarto de maquinas. El He se utiliza como gas de arrastre y el N, para la cdmara
de colisiones activadas.

8.2.2. Revise que la presion en los cilindros sea mayor de 500 psi. Caso la presion sea menor se debe
realizar el reemplazo por un cilindro lleno antes de que la presion llegue a 300 psi. Nota: si se trabaja con el
cilindro de He a presiones menores, se pueden introducir contaminantes que afectan el sistema.

8.2.3. Llene el formato de control de uso de gases que se encuentra en el cuarto de maquinas.

8.2.4. Abra las vélvulas de la linea de gases ubicadas en el &rea instrumental de cromatografia. Verifique la
presion de entrada de cada gas en el puesto de trabajo, el mandmetro debe mantenerse a una presion de 80
psi, véase Figura 3.

Figura 3. Lineas de gaseﬁ)ara el crbrﬁatégrafo EG-QqQ.

8.2.5. Conecte todos los equipos a la fuente de poder que se encuentra regulada por la UPS de 6 KVA,
incluyendo el computador. Verifique que la UPS esté funcionando correctamente. Las baterias deben estar full
y la carga que esta consumiendo el equipo debe ser aproximadamente del 10% de la capacidad de la UPS.
8.2.6. Revise el nivel de aceite de la bomba mecénica. Se debe realizar el cambio del aceite cada 6 meses,
maximo cada afio. La bomba mecanica debe estar con el botdn encendido en ON. El nivel del aceite no
puede estar por debajo del limite inferior como se muestra en la Figura 4.

Limite superior

Limite inferior

Figura 4. Verificacion del nivel de aceite de la bomba mecanica.

8.2.7. Encienda el computador del cromatografo con el boton de encendido de la CPU, luego oprima el boton
de encendido del monitor. Espere que cargue el sistema y digite el usuario “admin” contrasefia
“3000hanover”, también puede ingresar solamente con el usuario "ideam".
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8.2.8. Encienda el cromatografo de gases con el interruptor de alimentacion del GC que esté localizado en la
esquina inferior izquierda, debajo del compartimiento del horno cromatografico (véase Figura 1).

Automaticamente se encendera el muestreador automatico.

8.2.9. Encienda el detector selectivo de masas con el interruptor de alimentacién del MS ubicado en la
esquina inferior izquierda del médulo del detector de triple cuadrupolo (véase Figura 1). Automaticamente, se
encenderéa la bomba de vacio mecénica y se escucharé el ruido caracteristico del arranque del motor.

8.2.10. Ingrese al software MassHunter Workstation Version B.07.05. Haga doble click en el icono del "CG-

QQQ" que se encuentra en el DESKTOP, como se muestra en la Figura 5.

MS Qg
Quantitati... Quantitati...

@ BB

Sequence  Library Editor  Unki [ Agilent GC the

Table A... Analy Tra r|_5.I ator  Firmwar... ESSENTL...

A
Ly L

Parts Finder Agilent
Instrume...

Figura 5. icono del software Mass Hunter Data Acquisition program.

8.2.11. Espere unos minutos mientras abre el software y se establece la comunicacion entre el cromatdgrafo,
el detector y el software MassHunter Data Acquisition (véase Figura 6). Puede cerrar la ventana del GC
Status, los valores en tiempo real son mostrados en el Instument Control del monitor del computador.

Figura 6.Instrument control view del software MassHunter Data Acquisition.
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Nota: Para confirmar la comunicacion del sistema verifique la conexion oprimiendo el botdn "Options" en el
panel del GC, baja con la flecha del panel ¥ hasta "Communication", oprime "Enter". En el display del GC
apareceran los parametros de COMMUNICATIONS SETPOINTS, verifique que aparezca la direccion IP
192.168.254.11 perteneciente a la conexion con el cromatégrafo y la direccion 192.168.254.12 de la conexidn
con el espectrometro de masas.

Otra forma de confirmar la conexion del sistema con el cromatdgrafo y el detector puede ser mediante el
computador, ingresando al mend Inicio >> CMD. Digite el comando PING seguido de espacio y la direccién IP
del cromatdgrafo: “PING 192.168.254.11”, como se muestra en la Figura 7. Deben aparecer cuatro mensajes
con la especificacion TIL=64 al final que confirma la conexion entre los sistemas. Posteriormente, se repite el
proceso con el nimero de la direccion IP del espectrometro de masas, ingresar “PING 192.168.254.12". En el
caso en que no se compruebe la comunicacion correcta entre los sistemas, comunicarse con servicio técnico.

Bl C:\Windows\system32\CMD.exe | S

Microsoft Windows [Uersion 6.1.76611]
Copyright (c) 2889 Microsoft Cowporation. A1l rights reserved.

C:“Users\IDEAM>FPING 192.168.254.11

Pinging 172.168. 254 11 with 32 hytes of dat
3 254.11: hytes=32 t1ne<1m., TTL 64
.254. : hytes=32 time{ims TTL=64
. . hytes=32 time<{ims TIL=64
Reply from 192.168.254.11: hytes=32 time<ims TTL=64

Ping .,tatl.,tlc., for 192.168.254. 11
Pack Sent = 4, Received = 4. Lost = @ <Bx loss).
nd trip times in milli- recnndr
Minimum = Bms, Maximum = Bms, Average = Bms

C:\Users\IDEAM>PING 192.168.254.12

Pinging 192.168.254.12 with 32 hytes of data:

Reply from 192.168.254.12: hytes=32 time{ims TTL=64
Reply from 192.168.2 yte

Reply from 192.168.254. bytes=32 time<{ims TTL-64
Reply from 192.168.254. bytes=32 time<{ims TTL=64

Ping statistics for 192.168.254.12
Packets: Sent = 4, Received = 4, Lost = @ (Bx loss>.

Approximate round trip times in milli-seconds:
Hinimum - Bms. Maximun - Oms, Average — Bms

C:\Users~1DEAM>

Figura 7. Verificacion de la conexion del GC y MS, comando CMD.

8.2.12. Para accionar el alto vacio en el espectrometro de masas se ejecuta el procedimiento de
PUMPDOWN. Desde el MassHunter Data Acquisition program ir a [Instrument] > [MS Vacuum Control] o

desde el Instrument Control View dar click en el icono del Vacuum Control (véase

Figura 8).

°  6C-QQQ/Enhanced MassHunter - Clorotalonil MRM 15 pruebaMJ ATUNEU / 20170802 Transiciones. MRMsequence.

Method | Instrument

Inlet/In

Sequence View Abot  Window  Help

jection Types.. - @

:> O @ f?nstrumentControl view

Method Instrument

o«*fgl W

MS Sh

Switch Ion Source Filament..

I chrom, Run Agilent Instrument Utities

th\la (Torr) M1 Qu: dTMp(C]

uuuuuu

0.928

ow/Hide Status FimeICeiA] ‘ Turbo 1 speed (%) M52 Quad Temp. (‘C)

L 150 JI 0.0 |

Filament Current (uA)

\EIXT
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Figura 8. Vacuum Control del espectroémetro de masas.

8.2.13. Seleccione la opcion PUMPDOWN, en seguida se abrira una ventana en la que preguntan si le
gustaria cargar las temperaturas altas de (230/150/150) de la fuente de ionizacion y los cuadrupolos (MS1y
MS2), dar click en YES, como se muestra en |a Figura 9. El sistema demorara aproximadamente 20 minutos
en alcanzar los parametros especificados.

Pumpdawn

Pumpdown Cycle Started: 8/22/2017 9:08:54 AM

TR BRSO || s = R
Triple Quadrupole Vacuum

X m - = r - Turbo 1 Power w

Speed % Power (W) Source T
uuuuuuu =

Turbo 1 1000 208 MIS1 Quad Temp. =

S 6 a g 2
g g
g

MS2 Quad Temp. -

[eoeler]
000D US1645U003
Trple fuds Series 2 detector

Vent l I Pumpdonn ‘ l Bakeout, l [ ‘Air and Water Check ]

6 [T Print air and water check rsport

Abort Airand Water Check

Rough Vac 1.63E+2  mTor

Select Temperature Settings [

Figh Vac 10E4  Tor

(@) VWould youlike to load high temperature settings (230/150/150)7
& 1 not, 10071004100 will be loaded.

Dt =

Default CheckTune limits have been restored at 8/22/2017
9:08:39 AM.

Figura 9. Activacion alto vacio PUMPDOWN.

8.2.14. Verificar los pardmetros del espectrdmetro de masas, velocidad turbo (Turbo 1 Speed, 100 %), alto
vacio (high vacuum, entre 1 x 10-% - 5 x 10-° Torr), las temperaturas de la fuente de ionizacién (Source Temp,
230 °C) y los cuadrupolos (MS1 Quad temp, 150 °C y MS2 Quad Temp, 150 °C), como se muestra en la
Figura 10. Estos parametros también pueden ser observados en el INSTRUMENT CONTROL del MassHunter
Data Acquisition. Espere aproximadamente 2 horas hasta que el espectrémetro de masas alcance el equilibrio
térmico.

Pumpdown

Pumpdown Cycle Started: 9/8/2017 8:09:22 AM
Elapsed Time: 22 mins 47 secs

Actuals Crteria
Tubo 1 Speed 1000 £ |
Tutbo 1 Power %9 —w
Rough Vac 142E+2 —  mTor

High Val 55565 — Tor I J
Source Temp) 70 p—
W51 Guad Temp 150 — B
M52 Guad Temp 150 =

GCQua

70000 US1645U003 L
Triple Awis Series 2 detector

Figura 10. Parametros del espectrometro de masas.
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8.3. Comprobacion del estado del equipo
Se realiza el chequeo para verificar que el sistema no tenga agua ni aire, ademas del ajuste del detector con
el Autotune.

8.3.1. Air and Water Check

Para realizar la prueba de presencia de agua-aire seleccione en el Instrument Control el icono Vacuum

Control ®>[Air and Water Check], seleccione la opcién de imprimir el informe & Print air and water check
report. Antes de realizar la prueba le aparecera un mensaje en donde el software le recuerda que debe
apagar el flujo de gas de N de la celda de colisiones (Turn Off Collision Cell Nitrogen (N2) Gas). Para esto, el
flujo de N, puede ser apagado manualmente con el botdn del panel del cromatégrafo [Aux EPC #], en la
opcion CID Flow (N2) prosiga dando [OFF] > [Enter]. El sistema no puede contener agua porque puede
quemar el filamento. La presencia de aire indica que pueden existir fugas y es posible que dafie la columna.
Para la verificacion de la conformidad de la prueba se deben cumplir los siguientes criterios:

H.O Relacion 18/69 < 20 %
O, Relacion 32/69 <25%
N> Relacion 28/69 <10%

Si la relacion Naery @ Oz > 4:1 es un indicio de que hay contaminacion, una de las fuentes puede ser las
impurezas del cilindro de gas de He que se esta acabando. Por el contrario, si la cantidad de oxigeno es
mayor, puede ser atribuido a una posible fuga, la cual debe ser identificada y corregida.

Al finalizar la prueba de Air and Water Check, el soffware muestra el informe (véase Figura 11). Si la prueba
falla en la relacion del H.0 (%), se debe realizar un Bakeout para aumentar las temperaturas de la fuente de
ionizacion y los cuadrupolos y asi retirar la humedad (véase Seccion 8.3.2). Nota: todas las fallas deben ser
subsanadas antes de realizar el ajuste del detector.

1B & e Wors Coecr i

PFTBA Abundance (m/z 69) 67937675
Water Abundance (H20, m'z 18) 10169662.0
Oxygen Abundance (02, m/z 32) 232080
Nitrogen Abundance (N2, mz28)  86496.2

Ratio H20 to m/z 69 149.69 Limit <=20.00% -
Ratio O2to m/z 69 0.34% Limit <=2.50% OK
Ratio N2 to m/z 69 127% Limit <=10.00% OK
* Nitrogen values are caiculated from oxygen abundance

Figura 11. Informe de la prueba de Air and Water Check.
8.3.2. Bakeout

Para eliminar el agua del sistema se debe ejecutar Bakeout. Este procedimiento permite realizar una limpieza
térmica al detector aumentando las temperaturas de la fuente de ionizacion y los cuadrupolos. Seleccione en
el Instrument Control el icono Vacuum Control %> [Bakeouf]. Se debe modificar solamente el tiempo de
ejecucion, es recomendable establecer como minimo de tiempo 1 hora. Al finalizar el Bakeout realice
nuevamente la prueba de Air and Water Check conforme esta descrito en la Seccién 3.3.1. Verifique que
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todos los pardmetros cumplen con las especificaciones, caso no sean cumplidos los criterios de los valores de
H,0 realice nuevamente el Bakeout. Si el reporte de la prueba de Air and Water Check cumple con las
especificaciones requeridas en la Seccién 8.3.1, continuar con el Autotune (véase Seccion 8.3.3).

/\ \
\
/ \
y N
/
/s \\
/ N
\
¢
Bakeout starled, waiting 1o reach largel emperaturas \f__
s 1| Bakacut Seng Matnad S Actual Vabos T R T
i and eports | Aot | Advanced Atctna)
2 2 <
| 200 150 151 <
|
150 151
Bekceouttine [ 1] W am s 55
ot |
v Fo— f = ‘
7] P i and water chock repoct
T e - -
|

Figura 12. Eliminacion de la humedad mediante el Bakeout.

8.3.3. Autotune

Para realizar el ajuste del espectrémetro de masas se ejecuta el Autotune en el modo de El (ionizacion
electronica). Desde el MassHunter Data Acquisition program ir a [Instrumenf] > [MS Tune] o desde el

Instrument Control dar click en el icono del MS Tune ¥ (véase Figura 13).

° GC-QQQ/Enhanced MassHunter - Clorotalonil MRM 15 pruebaM / ATUNEU / 20170802 Transiciones MRM.sequence.

Method | Instrument | Sequence View Abort  Window  Help

Inlet/Injection Types. -

Instrui Sample Prep..,

Enable Sample Prep...
Run st et
Edit Monitors.

Sl 10.00

Run Time

OFQO

Method Instrument

MS Temp:

eratures..
(ST SDE((rum

= ) K 2

=2 ' C’) &= En/,— 7

::S(:ﬂush\’\/\ﬂfd ’7’7 8 82e+01 230 Off
Inlet a Aux-2 Temperats gh\/a (mTorr) Source Temp. EEJ

[=ltad] =

inl [SE T e iry Pump 1 Current (3) Turbo 1 Speed (5%) M52 Quad Temp. (°C)

Switch lon Source Filament...

Filament Current (uA)

A chrom: Run Agilent Instrument Utilities

=] =

Superimposed Chromatograms (Nermalize)

g 55
Acquisition Time (min))
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Figura 13. Acceso al Tune del MS a través del MassHunter Data Acquisition program.

Seleccionar la pestafia de [Autotune]>[Autotune], en el Autotune type dar click en @ El high sensitivity
autotune, en el Autotune Options dar click en Y Print autotune report, Save tune file when done y dar
click en ®Default name. Para ejecutar, dar click en el boton de Autotune localizado en el esquina inferior
derecha (véase Figura 14). Esperar hasta que termine el proceso. Cuando el ajuste haya finalizado, aparecera
una ventana de aviso con el mensaje de Autotune done, dar click en OK. El archivo con el informe del
Autotune quedara guardado en D:\MassHuntenGCMS\1\7000\Tune Reports. Seleccione la carpeta del
Autotune con la fecha en la que fue realizada el ajuste, el archivo atunes.eiex.tune.xml debe ser cargado en
el método de adquisicion que se va a utilizar. Dentro de la carpeta también encontrara el archivo de informe
guardado como TuneReport.

Triple Quadrupole MS Tune - atunes.ciextunexml — -

10
95
E
85
8

25 Waiting for the instrument ta be rea

65
5 Instrument State
g 55
g 5 Source Temperature 20C
© 5

4
35

3

dy
2

Quad 1 Temperature 150°C

15 Cl State:
1
05

ClGas Flow NAA i

0
02040608 1 121416 18 2 22 24 26 28 3 32 34 36 38 4 42 44 46 48 5 52 54
fass (mz] Cal Vil
al Valve

Files and Report{| Autotune | Avanced Autotune | Manual Tune | Vacuum Control
Autotune | Theck Tune | Emission cument 238 35007

Stabiization delay 19 seconds

Overide stabilization delay l [ Cancel ]

NCI autotune

Autotune Options

Dar click para L

1) Tun ook st iniciar el ajust
[C] Use custom autotune parameters @
l Bron l l Quick Tune ‘
Abort Tu
_ Default CheckTune limits have been resiored at 8/8/2017 2:20.50 PM_ [ Close. l [ Help l

Figura 14. Ejecucion del ajuste del MS a través del Autotune.

Después ejecute el Check tune para verificar que todos los parametros son satisfactorios para operar el
equipo. En la pestafia del [Autotune], seleccione [Check Tune]. En la esquina inferior derecha dar click en
Print Check Tune Report y en seguida para ejecutar el chequeo dar click en la opcion Check Tune (véase
Figura 15). Al finalizar evalue el informe del Check Tune (véase Figura 16). Verifique que todos los parametros
estén conformes con los valores y limites permitidos por el fabricante, el resultado debe ser OK en todos los
parametros para aceptar la conformidad del equipo para su uso. Un aumento en el valor del voltaje del
electromultiplicador (EMV>2500), puede ser un indicativo de contaminacion en la fuente de ionizacion.
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Triple Quad le MS Tune - atunes.eiex.tune.xml
Mass (miz) 219,00 counts 273562000
x107- 219.00
26
24
22
2
18-
16
2 e 69,00
3 17100
1.2-
! 2400
08
08
04 502,00
10000 A
02 163,00
ol om0 goo, [ ) 0 b, 20000, 23100 400 3sa00 40200 | ajgpp 46400 514.00 564.10 61410
40 60 80 100 120 140 160 180 200 220 240 260 280 300 320 " Mﬂt ‘Z]:!ED 380 400 420 440 460 4230 500 520 540 560 580 600 620 640
253 (i
| Fiies and Reports | Autctune | Advanced Autotune | Manual Tune | Vacuum Control
Check Tune Settings Air and Water Leak Chack
Mass assignmert <= 020 amufrom target mass
Ratio of waterto low mass <= 200 %
Lon mass isstope 3= 05 and< 16 % of target mass abundance
Ratio of nitrogen to low mass <= 100 %
Mid mass isctope >= 42 and <= 6.3 % of target mass abundance
High mass isctope >= 79 and e 123 %o target mass sbundance —
Rtio of mid mass o low mass 3= 50 % H
an Dar click para
Ratio of high mass to low mass >= 08 % Moo Gan Facor w0 »
Low s rcuser = 30 %oftoret messabrdarce i ™ iniciar el chequeo
<= 60 %of bunds
1 mass precusor g mass abundance Derk Curert Puss Count, HED On <= 0 pusesises
High mass precusor <= 120 %oftarget mass sbundance
Restore Check Tune Defauls l Load Check Tune Linis.. l l Save Check Tune Limis... I
Defauk Chock Tune fiits have been restored at 8/8/2017 2:23:17 P
| ‘ Abort Tune
_ Autotune - Finished - 8/8/2017 2:35:20 PM l Close l l Hep
Triple Quadrupele MS Tune - atunes.ciextune.xml
Mass (miz) 32.03 counts 48686.3, pw 0.74
50000- =
47500. Check Tune. - )
45000 Value Limit Result
42500-
preves MS1 Check Tune Results
Py Low mass assignment (target 69.00, actual 69.00) 0.00 <=020 oK
kst Mid mass assignment (target 264.00, actual 264.00) 0.00 <=020 oK
aot0, High mass assignment (target 50200, actual 502.00) 0.00 <=020 oK
000 Low mass isotope position (target 70.00, actual 70.10) 010 <=020 oK
227500, Mid mass isotope position (target 265.00, actual 265.00) 0.00 <=020 oK
S 25000 High mass isotope position (target 503.00, actual 503.02) 0.02 <=020 oK
22500 Low mass isolope ratio 110% >= 0.5% and <= 1.6% oK
20000 Mid mass isotope ratio 577% >=4.2% and oK
17500, High mass isotope ratio 1008% >=7.9% and oK
15000 Ratio of mid mass to low mass abundance 6171% >=5.00% oK
12500- Ratio of high mass to low mass abundance 2282% >=0.80% oK
10000- Low mass precursor ratio 0.20% <=30% oK
7500. s Mid mass precursor ratio 0.24% <=6.0% oK
5000 High mass precursor ratio 0.05% <=120% oK
2500- L ——
o MS2 Check Tune Results -
oo Low mass assignment (target 69.00, actual 69.00) 0.00 <=020 oK s
Mid mass assignment (target 264.00, actual 264.00) 0.00 <=020 oK
Files and orts | Autot Advanced Autotune | Mz o
Eoposa] Msonre | chre [ 1 1ioh mass assignment (targst 50200, actual 502.00) 0.00 <=020 oK
[Autotune | Check Tune Low mass isotope position (target 70.00, actual 70.10) 0.10 <=020 OK
. Mid mass isotope position (target 265.00, actual 265.00) 0.00 <=020 oK
eck Tune Setiing High mass isotope position (target 503.00, actual 503.00) 0.00 <=020 oK
2 Low mass isolope ratio 1.23% >= 0.5% and <= 1.6% oK
Mid mass isotope ratio 6.00% >=4.2% and <= 6.9% oK
= =eo=d| - High mass isotope ratio 9.66% >=79%and<=123%  OK
]| Lowmass precursor ratio 0.00% <=30% oK
Mid mass precursor ratio 0.00% <=6.0% oK
Hehmase seieee 4| High mass precursor ratio 1.26% <=120% oK
. Detector Check Tune Results
Fa | Emv 1020 <=2900 oK
Maximum Gain Factor 263860 >=100 oK
Air and Water Check Resuits
; Ratio of Water to PFTBA 162% <=200% oK
Ratio of Nitrogen to PFTEA 1.22% <=10.0% oK |
Restore Check Tt N ine.
Defat Check Tune limts have been restored ot 8/4 e report
|3

Figura 16. Resultados de la evaluacion del autotune a través del Check Tune.
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8.4. Apagado del equipo o venteo

8.4.1. Para proceder apagar el equipo, se puede bajar manualmente las temperaturas del GC. Desde el panel
de control apagar la temperatura del inyector (oprimir tecla [Front Inlef] > [Off]> [Enter]), el horno (Oven >
[30 °C] > [Enter]) y la interface ([Aux Temp #] > [Off]> [Enter]).

8.4.2. Realizar el venteo desde el software MassHunter Data Acquisition program, ejecute [Instrument]>[MS
Vacuum Control] o desde el Instrument Control dar click en el icono del Vacuum Control & Dar click en
[Vent] para comenzar el ciclo de venteo. El procedimiento de venteo incluye el enfriamiento de las zonas de
alta temperatura del equipo antes de perder el alto vacio del espectrémetro de masas. Un cuadro de diélogo
con el estado del sistema muestra los cambios en progreso del ciclo de venteo (véase Figura 17).

Triple Quadrupole Vacuum Control Vent

Status Venting

Vent Cycle Started: 9/14/2017 10:25:16 AM
ower (W) Eiapsed Time: € mins 50 sscs

Turbo 1 142 01 Actuals Criteria

Turbe 1Speed 142 <20 %
Rough Vac 874E+1 mTom
Turbo 1 Power ol —w

High Vac Of  Tor

Rough Vac 8.74E+1 — mTor

High Vac off — om

Source Temp. 152 <100

! I Vert l ‘ Pumpdown ‘ ‘ Bakeout ‘ ‘ Airand Water Check ‘ |
\

T
T

Prirt air and water check report MS1Quad Temp. 128 <10 C
T

128 <100

——

‘ MS2 Quad Temp.
Abort Air and Water Check

[eleteleld
7000D US1645U003
Trple A Series 2 detector

Help

Default CheckTune limits have been restored at 9/14/2017
10:25:13 AM.

| !
Figura 17. Ciclo de venteo para apagar el equipo.

8.4.3. Espere hasta que aparezca en la pantalla el mensaje de Vent "READY" y verifique que el horno y la
interface estén a temperatura ambiente antes de cerrar el flujo del gas de arrastre. Si se permite que entre
aire al sistema y las superficies estan calientes, el oxigeno podria generar dafios en estas partes del equipo.
Nota: en caso de ser estrictamente necesario el apagado répido debido a fallas de energia eléctrica, entre
otros, el equipo puede ser apagado cuando la velocidad de la turbo (Turbo 1 Speed, %) alcance
aproximadamente el 20%.

8.4.4. Cierre la ventana del software MassHunter Data Acquisition program y apague el computador.

8.4.5. Apague el cromatografo de gases con el interruptor de alimentacion del GC que esta localizado en la
esquina inferior izquierda, debajo del compartimiento del horno cromatografico.

8.4.6. Apague el detector selectivo de masas con el interruptor de alimentacién del MS ubicado en la esquina
inferior izquierda del modulo del detector de triple cuadrupolo.

8.4.7. Desconecte los equipos de la fuente eléctrica.

8.4.8. Cierre las llaves del flujo de gas de helio y nitrégeno.

8.5. Configuracion de los parametros del GC

8.5.1. Editar los parametros de configuracion del cromatégrafo de gases. Ingrese desde el Instrument control
MassHunter Data Acquisition program al menu Instrument >GC Parameters. En el panel izquierdo dar click
en Configuration, también se puede ingresar desde el icono del GC Parameters como se muestra en la
Figura 18. Se deben establecer las condiciones de los opciones de Miscellaneous, Columns, Modules y
ALS.
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* . OFF LINE/Enhanced MassHunter - DEFAULT.M / defaultei funexml / defaultsequence [ e |
Method | Instrument | Sequence View Abort Window  Help
Tnlet/Injection Types.. -B
- GC Parameters P —
e Edit Monitors... — =

GC Parameters... :
Run Aple -
- GC Real-Time Plots... Rl
GC Configuration...
Instr a File:
GC Show/Hide Status

Backflush Wizard
!Eratu re

Aux-2 Temperature Column-1 Flow Calc Collision Flow

High Vac (Torr) ‘ Rough Vac {mTorr) Quench Flow

IS Parameters...

M5 Temperatures...
MS Vacuum Control...
MS Tune...
Configure MS Source...
Configure M5 Gases...
Inlef MS Show/Hide Status

Filament Current (pA)

Source Temp ( c) MS1 Quad Temp. (*C) Spectrum

Figura 18. Parametros de configuracion del GC.

8.5.2. En la opcién Miscellaneous del panel de control izquierdo seleccionar las unidades de presidn, para
esto seleccione en el campo Pressure Units la opcion psi (véase Figura 19).

4§ GC Edit Parameters SR — P
a0 }
250
200
o
& 10
100
EY
o
o 1 2 El 4 s 3 7 s 9 10 1 12 1 14 1s 16 17 1 1 B
54 Run Time, min
Select... Pressure Units
Valve Configuration
« N ALS #
nas
FrontInjector | 1= Vatve Type Name Parameters
Tray / Other KPa » 1 [Notinstalled |+ (vaive#1)
F Inlets bar
1 Columns [ Siow Fan 2 [Notinstalied || (vaive sz
P oven 3 Not Installed || (Valve #3)
%Aux Heaters 1 [Netinstalied [+ (vaive#2)
% Events s [Notinstaned [+](vaiess)
& signals 5 [Notinstalled [+]valve#)
~ % Configuration 7 Not Installed | | (Valve #7)
¥, Miscellaneous 8 Not Installed |~ | (Valve £8)
Columns
Modules
ALs
@ Backflush
il Readiness
|5l 6C caleulators

Figura 19. Configuracién de las unidades de trabajo para la presion del GC.

8.5.3. Registrar la columna cromatogréfica. Ingrese al Instrument >GC Parameters. En el panel izquierdo dar
click en Configuration > Columns. Inicialmente se debe realizar la instalacion en el software de la columna
que se va a utilizar en el GC y calibrarla para mantener 6ptimas condiciones del flujo en la columna. Todas las
columnas de Agilent-J&W estéan disponibles en el catalogo guardado dentro del software. Para esto debe dar
click en el numero de la columna que se va a adicionar, después se abrira el cuadro de Edit Properties of
Installed GC Column. Seleccionar la columna desde el catalogo, si por el contrario la columna no es de
marca Agilent, se pueden registrar todos los datos de la columna de acuerdo con el fabricante. Para adicionar
la columna desde el catélogo, dar click en el botén Select from Catalog (véase Figura 20).
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Figura 20. Configuracion de la columna.

Seleccionar la columna de acuerdo con el Part Numbery dar click en Install (véase Figura 21).

il GC Column Catalog =TE =
Inventory.. Create Layout Update
~|| Fnd Clear [ Only Show Columns Added To Invertory

PartNumber | Ma... ~  Description Fav... | Lo DE;{' Tlr::ilgc— ':‘;;5 oo oE Teﬁ?f - .’:';;;’Sg . Keyw... | Comments | Time Stamp

» 771909157433 | Agilent  HP-5ms i~ 30 250 0.25 250 50 325 350 7dnch  HP-5ms 05/20/15 ...
190915-413 Agilent HP-5ms 30 320 0.25 320 -60 325 350 F-inch HP-5ms 05/20f15 ...
190915-433E  Agilent HP-5ms 30 250 0.25 250 -60 350 350 S-nch HP-5ms 05/20/15 ...
190915-416 Agilent HP-5ms 60 320 0.25 320 -60 325 350 F-nch HP-5ms 05/20/15 ...
190915-436 Agilent HP-5ms 60 250 0.25 250 -60 325 350 7-nch HP-5ms 05/20/15 ...
190915-577  Agilent  HP-5ms 20 180 0.8 250 60 325 350 7-nch  HP-5... 05/20/15 ...
190915-577E  Agilent  HP-5ms 20 180 0.18 250 60 325 350 Sdnch  Molo... 05/20/15 ...
190915-57... Agilent HP-5ms 20 180 0.18 250 -60 325 350 LT™ HP-5... 05/20f15 ...

i 190915-10... Agilent HP-5ms 12 200 0.33 152 -60 325 350 LT™ HP-5... 05/20/15 ...

190915-10... Agilent HP-5ms 25 200 0.33 152 -60 325 350 LT™ HP-5... 05/20/15 ...
190915-13... Agilent HP-5ms 30 250 0.5 125 -60 325 350 LT™ Mo Lo... 05/20/15 ...
190915-23... Agilent  HP-5ms 15 250 L 63 60 325 350 LTM Mo Lo... 05/20/15 ...
190915-23... Agilent | HP-5ms 30 250 1 63 60 325 350 LTM Mo Lo... 05/20/15 ...
190915-33... Agilent HP-5ms 15 250 0.1 625 -60 325 350 LT™ HP-5... 05/20f15 ...
190915-33... Agilent HP-5ms 30 250 0.1 625 -60 325 350 LT™ Mo Lo... 052015 ...
190915-43... Agilent HP-5ms 15 250 0.25 250 -60 325 350 LT™ HP-5... 05/20/15 ...
190915-43... Agilent HP-5ms 30 250 0.25 250 -60 325 350 LT™ HP-5... 05/20/15 ...
190915-11... Agilent HP-5ms 25 320 o052 154 60 325 350 LTM Mo Lo... 05/20/15 ...
190915-11... Agilent | HP-5ms 30 320 0.5 160 60 325 350 LTM Mo Lo... 05/20/15 ...
190915-21... Agilent HP-5ms 30 320 1 80 -60 325 350 LT™ Mo Lo... 05/20f15 ...
190915-31... Agilent HP-5ms 30 320 0.1 800 -60 325 350 LT™ Mo Lo... 052015 ...
190915-41... Agilent HP-5ms 30 320 0.25 320 -60 325 350 LT™ HP-5... 05/20/15 ...
122-4532 Agilent DB-5ms 30 250 0.25 250 -60 325 350 Mo Lo... 05/20/15 ...
cP7419 Agilent  Select FAME 50 250 o -58 275 200 74nch  Select... 05/20/15...

e «-:—‘;.2192f42-3; " P: ;N — .A.—f x - o - - o Tt o T
Frrt... Install [ pene | [ nHep

Figura 21. Seleccion de la columna cromatografica desde el catalogo.

Después dar click en el boton Create Inventory, se abrira el recuadro del Column inventory. Proceda a
registrar el nimero del serial de la columna en el campo del Inventory Number seguido de OK. El software
llevara el inventario de las diferentes columnas que se utilicen de acuerdo con el serial que se registre, asi se
podra llevar la trazabilidad cada vez que se cambia por una columna nueva con las mismas especificaciones.
Posteriormente, seleccionar las partes de entrada y salida en la que estara conectada la columna dentro del
cromatégrafo. En este caso en el campo del Inlet deberé seleccionar Front Inlet y en el campo del Outlet
seleccionar MSD. En el campo Heated By seleccionar Oven conforme se muestra en la Figura 22.
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Figura 22. Registro de la columna cromatografica en el inventario del software.

Nota: si la columna registrada en el software no se va a utilizar inmediatamente en el equipo, se recomienda
establecer el campo del Inlet de la tabla como Unspecified para evitar que genere errores en el calculo de
las presiones y flujos del sistema.

8.5.4. Calibracion de la columna. Es importante realizar la calibracion de la columna para que el equipo pueda
realizar una estimacion real de las dimensiones y calcule correctamente los flujos y presiones durante la
corrida cromatogréfica. El procedimiento para realizar la calibracion en el software es el siguiente: desde el
menU o desde la parte gréfica dar click Instrument >GC Parameters. En el panel izquierdo dar click en
Configuration > Columns > Calibrate > Calc Length. Registrar el tiempo de muerto determinado a partir de
la inyeccién de una sustancia no retenida en la columna en el campo del Holdup time of an Unretained
Peak, en seguida dar click afuera del dato registrado para verificar que se hayan realizado los ajustes.
Verificar los datos de los demas parametros (temperature, inlet and outlet pressures, y gas type) utilizados
para determinar el Holdup Time. Actualice cualquier parametro que sea diferente al utilizado en el método de
adquisicion. Finalmente dar click en Ok (véase Figura 23).
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Figura 23. Calibracion de la columna cromatografica.

Al finalizar el proceso, verificar que en las especificaciones de la columna en la tabla del meni Column
aparezca en el item de Calibration result |a fecha de calibracion. De esta forma, se confirmara que se hayan
guardado los cambios de la calibracion.

Es posible determinar el tiempo muerto inyectando aire, se verifica el tiempo de elucién de los iones de Ny y
CO, (m/z 28 y 32, respectivamente), a través del cromatograma de ion extraido desde el software Qualitative

MassHunter (véase Seccion 8.9.6).

8.5.5. Desde la configuracion del GC seleccione los gases para los diferentes médulos. Ingrese a Instrument
>GC Parameters. En el panel izquierdo dar click en Configuration>Modules. Desde la opcidn Front Inlet en
el campo de SS Inlet seleccionar el helio: He. Para la opcién Collision Cell/Backflush en el campo Quench
Gas, automaticamente establece el He porque es el gas de arrastre. En el campo de Collision Gas
seleccione el nitrdgeno: N, finalmente para el Backflush Gas seleccione el helio: He (véase Figura 24).



INSTRUCTIVO DE MANEJO DEL Cédigo: M-S-LC-1013
CROMATOGRAFO DE GASES ACOPLADO AL | Version: 01

AN g DETECTOR SELECTIVO DE MASAS DE TRIPLE
I D EA M Meteorologia y

Fecha: 14/12/2017
Estudios Amblentales CUADRUPOLO AGILENT GC 7890B/QqQ 7000D

Pagina: 19 de 54

ol GC Edit Par 3 - -

300

250

200

150

100

=)
ul

°C

_ 1] 1 2 3 4 5 [} 7 ] ] 10
Select... Front Inlet
Front Injector -
Jh Collision CellfBackflush
Tray / Other Quench Gas |He
4 Inlets
3:_' columns Collision Gas
Vi
Ed oven Backflush Gas
& Aux Heaters
3 Events
li. Signals

~ % Configuration
Miscellaneous
Columns
%" Modules
ALS
&} Backflush
il Readiness
l&l Gc calculators

Figura 24. Configuracion de los gases en los moédulos del GC-QQQ.

8.5.6. Configuracién ALS. Desde la configuracién del GC seleccione los pardmetros para el automuestreador
ALS. Ingrese Instrument >GC Parameters. En el panel izquierdo dar click en Configuration > ALS. Ingrese
tamafio de la jeringa, para esto en Syringe Size establezca 10 uL. En el modo de lavado de solvente, se
utilizaran solo los frascos Ay B. Entonces en Solvent Wash Mode, seleccione A, B (véase Figura 25).
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Figura 25. Configuracion del muestreador automatico para liquidos ALS.

8.6. Creacion de un método

8.6.1. Inicialmente para la creacion de un nuevo método puede ser generado a partir de modificaciones del
método de Default. Dar click en [Method] > [Load Method] y seleccione Default.m (véase Figura 26). El
Default es un método vacio solamente con los requerimientos minimos como presién del gas de colision,

caracteristicas de la columna instalada, entre otros. Por tanto, se deben modificar los parametros deseados a
partir de este archivo.
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Figura 26. Creacion de un nuevo método a partir del archivo de default.

8.6.2. Guarde el método con un nuevo nombre. Dar click en [Method] > [Save Method As]. Seleccionar la
carpeta donde quedara guardado el método (Method Path) y el nombre del método (Method File), conforme
se muestra en la Figura 27Figura 27. Nota: guardar los métodos en la D:\MassHunter\GCMS\1\methods.
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Figura 27. Ruta para guardar el método.

8.6.3. Seleccionar el tipo de inyector y fuente de la inyeccion. Dar click en [Instrument] > [Inlet/Injection
Types]. En la entrada de la muestra (Sample Inlet) seleccionar GC. En la fuente de inyeccion (Injection
Source) se debe seleccionar el muestreador automatico para liquidos (GC ALS). Como se esta trabajando
con detector selectivo de masas, seleccione en la caja de didlogo ¥ Use MS. En la localizacién del inyector,
seleccionar Fronty la conexion del MS (MS Connected to) seleccionar Front (véase Figura 28).
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Figura 28. Establecer los parametros del inyector Inlet/Injection Type

8.6.4. Seleccionar parametros del automuestreador. Ingrese desde el menu Instrument >GC Parameters
después seleccione en el panel izquierdo ALS > Front injector (véase Figura 29).

8.6.4.1 En el campo de Injection, la Syringe Size muestra automaticamente el tamafio de la jeringa
establecido anteriormente desde la configuracion del GC. Seleccione el volumen de inyeccion en el campo
Injection Volume, puede seleccionar un volumen desde 1 pL. Tenga en cuenta la capacidad del liner para
establecer el volumen de inyeccion.

8.6.4.2 En el campo de Washes and Pumps ingresas los datos.

e Enlaopciéon Solvent A Washes ingrese el nimero de veces que desea que la jeringa sea lavada antes
de la inyeccién en el campo de Preinj y después de la inyeccion en el campo Postinj con el Solvente A.
Se recomienda que el volumen de lavado sea el méximo de la capacidad de la jeringa, es decir,
establezca en el campo del Volume (L) la opcién Max.

e Enlaopciéon Solvent B Washes ingrese el nimero de veces que desea que la jeringa sea lavada antes
de la inyeccion en el campo de Preinj y después de la inyeccién en el campo Postinj con el solvente B.
Se recomienda que el volumen de lavado sea el méximo de la capacidad de la jeringa, es decir,
establezca en el campo del Volume (uL) la opcién Max.

o Enlaopcién Sample Washes ingrese el nimero de veces que desea que la jeringa tome una alicuota
de la muestra y en el campo Volume (uL) el volumen que debe tomar. Se recomienda que sea el mismo
volumen de inyeccion. Tenga en cuenta que en este proceso la muestra tomada seré descartada en el
vial de residuos de la torre de inyeccién.

o Enlaopcién Sample Pumps ingrese el nimero de veces que dese que la jeringa realice la purga con la
muestra antes de la inyeccion.

Las demas opciones proveen capacidades adicionales para muestras viscosas y grandes volumenes de

inyeccion. Para una visualizacion de la opcion en el Front injector, véase Figura 29.
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Figura 29. Parametros del automuestreador, torre de inyeccion.
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8.6.4.3 Calculo del volumen de vaporizacion del solvente. Antes de realizar la inyeccion, debe asegurarse que

el volumen de solvente inyectado es compatible con la capacidad del liner que se va a utilizar. Agilent tiene
una herramienta que ayuda a determinar esta condicion. Ingrese desde el menl Instrument >GC
Parameters, después seleccione en el panel izquierdo GC Calculators > Vapor volume calculator. El

soffware calcula el volumen aproximado de vaporizacion del solvente de acuerdo con la cantidad inyectada,
tipo de liner, temperatura del puerto de inyeccion y presién en el inyector, esta Ultima es muy importante en el
caso que se trabaje con inyeccidn pulsada. De esta forma se puede verificar que el volumen inyectado no
sobrepasa la capacidad del liner y que se realizara la transferencia cuantitativa a la columna, evitando que se
genere contaminacion en el puerto de inyeccion, véase Figura 30.
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Figura 30. Calculo del volumen de vaporizacién del solvente.

8.6.4. Desde el Instrument >GC Parameters seleccione en el panel navegacion izquierdo ALS > Tray/Other.
En el campo ALS Errors, escoger la opcion Pause for user interation (véase Figura 31).
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Figura 31. Parametros del automuestreador, bandeja Tray/Other.
8.6.5. En el menu del panel de navegacion seleccionar Inlets, como se muestra en la Figura 32.

o Enel campo Split-Splitless Inlet, de click en el boton Select liner, si el liner es de marca Agilent,
seleccione el tipo de liner desde el catalogo.

o Active las opciones del Heater, Pressure y Septum Purge Flow dando click en la caja de dialogo.
Ingrese los valores de acuerdo de los pardmetros deseados.

e Enel campo Septum Purge Flow Mode puede seleccionar la opcién Switched.

e En el campo de Mode, puede seleccionar la inyeccion de tipo Split, Splitless, Pulsed Split, Pulsed
Splitless y Sleep. Recuerde que de acuerdo con el tipo de inyeccion debe establecer los valores del
Split Ratio, Split Flow (mL/min), o de la presién del pulso en el campo de Injection Pulse
Pressure (psi).

e Serecomienda activar el Gas saver cuando el Total Flow sea mayor de 15 mL/min
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Figura 32. Parametros del puerto de inyeccion.
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8.6.6. En el menu del panel de navegacion seleccionar Columns, como se muestra en la Figura 33. En el
campo Selection se debe escoger la columna que se va a utilizar. En el campo Control Mode, seleccionar la
caja de On. Introducir los datos relacionados con el Flow, Pressure, Average Velocity y Holdup Time. En
este caso se va a trabajar a flujo constante para que el equipo realice el control de las presiones y mantenga
el flujo. Para esto seleccione Constant Flow. Establezca el flujo de trabajo para el Post Run.

Select... [7 Selecton
- N, ALS Front S5 Inlet He —> Control Mods
1

. Agilent 190915-433: 81283871 on setpoint
Front Injector

Tray / Other
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[ Aux Heaters Holdup Time 13588 min Out: MSD

2 Events
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- ¥ Configuration

Miscellaneous
Columns e —rBTUmn BT CornEursTon
Modules
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& Backflush
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|l GC caleulators
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30 m x 250 pm x 0.25 pm

Constant Flow -

PostRun: 1.2 mL/min

Change Column. Calibrate Column, Lock Column

Figura 33. Parametros de la columna cromatografica y control de presiones y flujos.

8.6.7. Parametros del horno cromatografico. En el menu del panel de navegacion izquierdo seleccionar Oven,
dar click en la caja del Oven Temp On e introducir la temperatura de inicio de la corrida cromatogréfica. El
campo de Equilibration Time (min), se refiere al tiempo utilizado para estabilizar el equipo después que ha
alcanzado las condiciones de flujo y temperatura para iniciar una nueva corrida. En el campo Maximum Oven
Temperature, establecer la temperatura maxima que puede alcanzar el horno de acuerdo con la temperatura
maxima permitida por la columna. Configurar la rampa de temperatura del horno. Si desea puede activar el
Post Run introduciendo la temperatura a la que llegaria el horno después de finalizar la corrida
cromatogréfica y el tiempo que dura en el campo del Post Run Time (véase Figura 34).

Ramp 1 ) 180 2 56567
Ramp 2 3 £ 0 x

Romp & ) =0 s 3078

Figura 34. Programa de temperatura del horno cromatografico.
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8.6.8 Parametros de la linea de transferencia. Como se esta trabajando con el detector selectivo de masas,
se debe establecer la temperatura de la linea de transferencia del acople del GC al MSD. En el men( del
panel de navegacion izquierdo seleccionar el icono del Aux Heaters. En el campo del Thermal Aux 2 (MSD
Transfer Line), activar el calentamiento dando click en On y establecer la temperatura en °C como se
muestra en la Figura 35. La temperatura de la linea de transferencia o interface debe ser lo suficientemente
alta para mantener la muestra vaporizada, pero no puede superar la temperatura maxima permitida para la
columna. Al finalizar guarde los cambios en Method > Save. Luego proceda a establecer los parametros de
adquisicion del espectrometro de masas.

Select...

Thermal Aux 2 (MSD Transfer Line)
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Front Injector
Tray / Other
4 Inlets
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& Backflush

§fl Readiness

|# GC Calculators

Figura 35. Parametros de la linea de transferencia.

8.7. Configuracion del detector selectivo de masas de triple cuadrupolo.

El equipo del Laboratorio de Calidad ambiental del IDEAM es un cromatdgrafo de gases acoplado al detector
selectivo de masas tandem en el espacio con analizador de triple cuadrupolo, es decir, tres cuadrupolos
acoplados en serie. Uno de los cuadrupolos actla como una camara de colisiones. De acuerdo con la
configuracién del detector de triple cuadrupolo, el equipo puede operar en diferentes modos de monitoreo, a
saber: barrido completo (Full Scan), monitoreo de iones seleccionados (SIM, selected lon Monitoring), barrido
de ion producto (Product lon Scan), barrido de ion precursor (Precursor lon Scan), barrido de fragmento
neutro (Neutral Loss lon Scan), monitoreo de reacciones multiplas (MRM, Multiple reaction monitoring) y
dinamic MRM.

El procedimiento para establecer los parametros del espectrémetro de masas MS es el siguiente:

e Desde el GC-QQQ MassHunter Acquisition software vaya al menu Instrument > MS Parameters o
desde el icono como muestra la Figura 36.
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Figura 36. Ruta de acceso para el MS parameters.

e En el campo de Method > Acquisition.
o Registre las informaciones del MS Parameters, véase Figura 37 .
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Figura 37. Parametros del método en el detector de triple cuadrupolo.

e En el campo de Tune File, seleccione el archivo del ultimo Autotune realizado.

e En el campo de Source Parameters, la lon Source esta preestablecida como El (es decir, Electron
lonization o ionizacion electrénica). La temperatura de la fuente o Source Temperature (°C) puede
establecerse en 230 °C. Electron Energy Mode, seleccione Use Tune Setting y la energia de
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ionizacion o Electron Energy (eV) esta predeterminada como 70 eV.

e En el campo de Detector Setting se recomienda trabajar con el factor de ganancia. Seleccione Use
Gain Factor.

e En el campo de Run Time se recomienda establecer el tiempo del Solvent Delay (min) para que el
filamento del MS esté apagado mientras eluya el solvente. Recuerde que demasiada humedad puede
quemar el filamento. Ingresar el tiempo de la corrida cromatografia en que se va encender el
filamento.

e En el campo de Time Filter activar dando On y activar las casillas del Automatically Substract
Baseline y Advance MRM/SIM Filtering.

A continuacién se explicara las opciones para ajustar algunos de los modos de adquisicion del MS en el
campo de Time Segments.

8.7.1. Entre los experimentos que se pueden realizar esta el Full Scan (barrido completo), este tipo de
monitoreo es equivalente al que se realiza en un equipo con cuadrupolo Unico, es decir, la camara de
colisiones Q2 no esta activada. El triple cuadrupolo QQQ Agilent 7000D, permite realizar este tipo de scan en
cualquiera de los dos cuadrupolos (Q1 o Q3). En el software se puede identificar como MS1 Scan o MS2
Scan. En este caso es recomendable que el primer cuadrupolo Q1 (analizador de masas MS1) y la cdmara de
colisiones Q2, estén operando en el modo de transmision de iones o Total Transmision lon (TTI), permitiendo
el paso de todos los iones al segundo cuadrupolo Q3 (analizador de masas MS2) que trabajara como un filtro
de masas y por ultimo los iones llegan al detector. Con las corrientes idnicas totales se construye el espectro
de masas. Preferiblemente se debe trabajar en el modo MS2 Scan, dado que el cuadrupolo esta mas cerca al
detector.

En la Figura 38 se muestra un ejemplo para la seleccién del modo de monitoreo del tipo Scan.

e Enel campo de Scan Type seleccionar MS2 Scan.

e En el campo Gain establecer el valor de la ganancia, puede estar en el rango entre 1-10.

e Dar click en la casilla del Data Saved.

e En la regién superior derecha del display, en Scan Segments establecer el rango de masas en el
que se va trabajar. Para esto en la opcidn del MS2 Start Mass establecer el valor de 45 (m/z). En la
opcién MS2 End Mass ingresar el valor de 500 (m/z), si desea analizar masas mayores puede
aumentar el rango. En la opcién del Scan Time se debe ingresar un valor en el cual el nimero de
Data samples sea aproximadamente 3.

e En la region inferior derecha del display, en Scan parameters en el campo de Step size (amu)
seleccionar 0,1. El valor del Threshold puede establecerse entre 50 o 100.

¢ Finalmente dar click en OK 'y guardar los cambios en Methods > Save.
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Figura 38. Parametros para operar el MS en el modo MS2 Scan.

8.7.2 En el monitoreo de ion (es) seleccionado (s), SIM, se programa uno de los cuadrupolos para que deje
pasar solo los iones tipicos y especificos del analito que fueron previamente seleccionados. Los otros dos
cuadrupolos trabajan en el modo TTI. Con base en las corrientes iénicas parciales obtenidas se construye el
fragmentograma de masas. El equipo permite trabajar en el modo SIM en cualquiera de los dos cuadrupolos
(MS1 SIM 'y MS2 SIM). Como en el caso anterior, se recomienda trabajar en el modo MS2 SIM.

En la Figura 39 se muestra un ejemplo para la configuracion del modo de SIM.

En el campo de Scan Type seleccionar MS2 SIM.

En el campo de Time (min), ingresar el tiempo de retencion del compuesto de interés que puede ser
determinado a través de la adquisicion por Scan. Pueden ingresarse varios segmentos o ventanas de
monitoreo, es decir, el tiempo de retencion para la adquisicion de varios analitos.

En el campo Gain establecer el valor de la ganancia, puede estar en el rango entre 1-10.

Dar click en la casilla del Data Saved.

En la region superior derecha del display, Scan Segments ingresar el nimero de filas de acuerdo con la
cantidad de iones que se van a monitorear en ese segmento a través de los iconos '= = = . Ingrese el
nombre del compuesto que va a monitorear. En el campo de MS2 mass, ingrese la masa de los iones
que desea monitorear. En el campo de MS2 resolution seleccione la resolucién Wide (1,2 uma) y como
Dwell time (min) ingrese un valor de 50.

En la region inferior derecha del display se muestra la opcién de Full Scan parameters, si desea puede
habilitar la adquisicion simultanea de SIM y Scan, dando click en la casilla Enable.

Finalmente dar click en OK'y guarde los cambios en Methods > Save.
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Figura 39. Parametros para operar el MS en el modo MS2 SIM.

8.7.3. Barrido de ion producto (Product lon Scan), el ion precursor o ion padre se seleccion en el Q1 (MS1) y
se transfiere al Q2 (camara de colisiones activadas), donde interacttia con el gas de colision, y el gas ionizado
de He, promoviendo la fragmentacién del ion para generar los iones productos o iones hijos. Los fragmentos
son entonces escaneados en el Q3 (MS2). Esto da como resultado un fragmentograma tipico de un andlisis
tandem MS/MS. El monitoreo de iones producto sirve como un paso Uil en el desarrollo del método MRM o
en el caso donde se intenta elucidar la estructura de un ion precursor.

En la Figura 40 se muestra un ejemplo para la seleccién del modo de ion producto.

En el campo de Scan Type seleccionar Product lon.

En el campo de Time (min), ingresar el tiempo de retencion del compuesto de interés que puede ser
determinado a través de la adquisicion por Scan. Pueden ingresarse varios segmentos o ventanas de
monitoreo, es decir, el tiempo de retencion para la adquisicion de varios analitos.

En el campo Gain establecer el valor de la ganancia, puede estar en el rango entre 1-10.

Dar click en la casilla del Data Saved.

En la region superior derecha del display, Scan Segments ingresar el nimero de filas de acuerdo con la

cantidad de iones que se van a monitorear en ese segmento a través de los iconos === . En el
campo Segment Name ingrese el nombre del compuesto que va a monitorear. En el campo de
Precursor lon, ingrese la masa de los iones que desea escanear el Producto lon. En el campo de MS1
Resolution seleccione la resolucion Wide (1,2 uma). En el campo MS2 Start Mass ingrese un valor de
masa menor para que empiece a hacer el barrido. En el campo MS2 End Mass ingrese un valor masa
mayor al del ion precursor. En la opcidn del Scan Time se debe ingresar un valor en el cual el numero
de Data samples sea aproximadamente 3. En el campo CE (eV) ingrese la energia de colision para
realizar la fragmentacion en la cdmara de colisiones.

En la region inferior derecha del display se muestra la opcién de Scan parameters, en el campo de
Step size (amu) seleccionar 0,1. El valor del Threshold puede establecerse entre 50 0 100.

Finalmente de click en OK y guarde los cambios en Methods > Save.
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Figura 40. Parametros para operar el MS en el modo de monitoreo de barrido de ion producto.

8.7.4. Monitoreo de reacciones multiples (MRM, Multiple reaction monitoring). MRM es conocido como la
herramienta final de analisis de compuestos que no produce un espectro completo. Puede producir resultados
muy especificos y sensibles. En este modo de adquisicion es seleccionado un ion precursor del analito en el
Q1 (MS1), el ion es fragmentado en el Q2 (camara de colisiones) y entonces se selecciona un ion proveniente
de la fragmentacion, es decir, ion producto de la transicion o reaccidn de disociacion para ser filtrado en el Q3
(MS2). Ambos analizadores, MS1 y MS2, operan en modo SIM. De este modo, solo los iones producto
generados por la fragmentacion del ion precursor pasado a través de Q1 son detectados.

El monitoreo de la reaccién del ion precursor e ion producto, permite confirmar la presencia del analito en
mezclas complejas. Asi, la identificacion de dos transiciones independientes, ademas de la equivalencia del
tiempo de retencidn cromatografico con la de un patron certificado, confirma la identificacion inequivoca del
analito.

En la Figura 41 se muestra un ejemplo para la seleccion del modo de MRM.

En el campo de Scan Type seleccionar MRM.

En el campo de Time (min), ingresar el tiempo de retencién del compuesto de interés. Pueden
ingresarse varios segmentos o ventanas de monitoreo, es decir, el tiempo de retencion para la
adquisicion de varios analitos.

e  Enel campo Gain establecer el valor de la ganancia, puede ser en el rango de 1-10.

e Dar click en la casilla del Data Saved.

e  Enlaregion superior derecha del display, Scan Segments ingresar el numero de filas de acuerdo con la
cantidad de iones que se van a monitorear en ese segmento de tiempo a través de los iconos = == |
En el campo Compound Name ingrese el nombre del compuesto que va a monitorear. En el campo de
ISTD, seleccione la casilla si va a utilizar estdndar interno. En el campo de Precursor lon ingrese la
masa m/z del ion que desea monitorear. En el campo de MS1 Resolution seleccione la resolucion Wide
(1,2 uma). En el campo Product ion ingrese un valor de m/z del ion producto proveniente del ion
precursor que desea monitorear. En el campo MS2 Resolution seleccione la resolucién Wide (1,2 uma).
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En el campo Dwell (min) puede establecer un valor de 50 y en campo de CE (eV) ingrese el valor de la

energia de colision para realizar la fragmentacién en la camara de colisiones.

Nota: la energia de colision debe ser optimizada a fin de obtener la mayor abundancia de la

reaccion o transicion.

e En la regién inferior derecha del display se muestra la opcion de Full Scan parameters, si desea

puede habilitar la adquisicion simultdnea de MRM y Scan, dando click en la

casilla Enable. Tenga en

cuenta que esto podria disminuir la sensibilidad para la deteccion de los analitos.

o Finalmente dé click en OK'y guarde los cambios en Methods > Save.
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Figura 41. Parametros para operar el MS en el modo MRM.

8.8. Creacion de la secuencia para inyeccion automatica de las muestras.

La creacién de la secuencia de analisis se hace mediante el ment Sequence del Instrument control. También

puede acceder a través de los iconos graficos como se muestra en la Figura 42.

“ GC-QQQ/Enhanced MassHunter - Clorotalonil MRM 15 prueba.M / ATUNEU / 20170802 Transiciones MRM.sequence xm
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Quench Flow
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Figura 42. Ruta de acceso para la creacion de secuencias de analisis.
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8.8.1. La secuencia puede ser creada por modificacion del archivo default. Desde el menu Sequence
seleccione Load Sequence o el icono & y abra el archivo de default, default.sequence.xml.

8.8.2. Para abrir el archivo dar click en el menti Sequence>Edit Sequence o desde el icono %. Aparecera la
tabla de secuencia como se muestra en el Figura 43.

2 | NewSaplet) + X | @ @ | Teob =

Figura 43. Tabla de secuencia de analisis.

En el campo Name, ingrese el nombre de la muestra, puede contener hasta 30 caracteres. No se debe

incluir /, %, (,) o espacio preferiblemente guion al piso.

e En el campo Vial ingrese la posicidn del vial en la bandeja del automuestreador ALS.

e  En el campo de Method Path seleccione la carpeta donde se encuentra guardado el método.

e Enel campo Method File, seleccione el método que se encuentra dentro de la carpeta del Method Path.

e En el campo Data Path, seleccione la carpeta donde seran guardados los archivos generados durante la
corrida cromatogréfica.

o  Enel campo Data File, ingrese el nombre con el que quedara guardada la muestra.

o Enel campo Type seleccione el tipo de muestra.

e En el campo Level opcionalmente seleccione el nivel de concentracidn de la curva de calibracion desde
menor a mayor concentracion. Solo aplica para el tipo de muestra seleccionado como calibrante.

e  En el campo Dl ingrese el factor de dilucién de la muestra. Dado el caso en el que no se haya realizado
dilucién ingrese el valor de 1.

e Enelcampo de Vol. Ingrese el valor del volumen de inyeccién, en el caso en que desee modificar el del
método.

e Los campos Sample Prep P, Sample Prep, Tray Name, no es necesario modificarlos. Son utilizados en
caso de preparacion de muestras in situ. El equipo del Laboratorio de Calidad ambiental del IDEAM, no
utiliza esta configuracion.

e En el campo Comment, se puede adicionar informacion de las muestras. Tener en cuenta que esta

informacién no puede ser modificada después de la corrida de la muestra.

8.8.3. Guardar la secuencia. Ir al menu de Sequence > Save Sequence As. Ingresar el nombre de la
secuencia inicialmente con la fecha de creacion. Registrar el Afio, mes, dia y nombre de la secuencia.

8.8.4. Después de crear la secuencia se recomienda realizar la simulacion para verificar los datos y el espacio
disponible en el disco duro del equipo. Vaya al menu Sequence > Simulate sequence. Ingrese el nombre del
operador y verifique la ubicacién de la carpeta donde quedaran guardados los datos, es decir, el Data file
Directory. Dar click en Simulate sequence. Revisar que toda la informacién esté correcta y que la ubicacion
de las muestras esté de acuerdo con el nimero de la secuencia. Recuerde que si el automuestrador, no
encuentra el vial en la posicion de la bandeja que fue programada, la secuencia se detendra.
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8.8.5. Llenar los frascos de solvente Ay B, dispuestos en la torre de inyeccién automatica.

8.8.6. Una vez verificado los datos y posiciones de los viales, se puede proceder a ejecutar la secuencia. El
software correra la secuencia que estd actualmente cargada en la memoria. Seleccionar desde el menu del
Instrument Control la opcion Sequence > Run Sequence. Es necesario que de click en el botén Run
Sequence para que la secuencia arranque. Nota: si da click en OK, la secuencia no sera ejecutada.

8.8.7. Verificar que se realice la primera inyeccién para asegurarnos que la secuencia se ejecute.

8.8.8. Inyeccion individual. El software permite realizar una inyeccién individual sin necesidad de ejecutarla
desde la secuencia. En este caso, la muestra sera corrida con el método que se encuentra cargado en el
MassHunter Acquisition. Para comenzar, desde el Instrument Control, haga click en Method>Run method.
Seleccione la ubicacion en donde desea que se guarde el Data File, ingrese el nombre de la muestra,
posicién del vial. Finalice dando click en OK and run method.

8.9. Analisis cualitativo a través del software MassHunter

Inicialmente se realizara una breve descripcién de la interface del Qualitative Analysis MassHunter Version
B.0700 SP2. Este programa permite realizar el analisis cromatografico, ademas de la identificacion de
sustancias por el espectro de masas. Dentro de los manuales del equipo, se encuentra disponible un DVD y la
memory Stick el manual del eFamiliarization, que cuenta con los manuales con interface grafica muy didactica
para usuarios del software Qualitative y Quantitative.

8.9.1. Para ingresar al software dar doble click en el icono disponible para MassHunter Qualitative
Analysis software en el DESKTOP del computador. Alternativamente, vaya al menu de inicio del 7
computador Programs > Agilent > MassHunter WorkStation > Qualitative Analysis. Andyi..

%

8.9.2. Al comenzar, se abrira el programa con el disefio inicial o layout de default que contiene las ventanas
como se muestra en la Figura 44.
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Figura 44. Interface del software Qualitative Analysis MassHunter.

El software de Qualitative Analysis MassHunter se divide en cinco areas definidas en el estandar del layout.
En primer lugar, el Data Navigator lista los archivos de datos abiertos, los cromatogramas extraidos, los
espectros, y los compuestos asociados con el archivo de datos. La ventana del Chromatogram window
muestra los cromatogramas definidos y los cromatogramas de iones extraidos (EIC, Extracted lon
Chromatogram) o de MS/MS. EI Method Explorer permite seleccionar una funcion y luego utilizar el Method
Editor para establecer los parametros para esa funcién que desea.

8.9.3. Para abrir el archivo vaya al menu File>Open Data File, véase Figura 45. Seleccione el archivo que
desea abrir. La ruta de acceso para los Data file generados después de la corrida cromatografica es
D:\MassHunte\GCMS\1\Data. Deshabilite la casilla de Load Result data para tener el archivo madre sin que
se guarden las modificaciones. Dar click en Open.
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Figura 45. Ruta para abrir los Data File desde el software Qualitative Analysis.

8.9.4. El panel del Data navigator muestra los Data files que son abiertos dentro del Qualitative Analysis
software. El usuario puede seleccionar la informacion del cromatograma que desea observar en el panel del
Chromatogram Window. Asi, informacién asociada a ese data File como el cromatograma de la corriente
ibnica total reconstruida o TIC, pueden ser seleccionadas o deseleccionadas en las casillas de checkbox,
véase Figura 46.
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Figura 46. Panel del Data Navigator del software Qualitative Analysis.
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8.9.5 Para ampliar alguna region del cromatograma o del espectro de masas, realice el zoom dando click con
el boton derecho en la ventana y arrastre el cuadro alrededor de los datos que desea ampliar o dando click
derecho sobre el eje y arrastre para hacer zoom. Utilice los botones de escala automatica para devolver los
datos a la escala |n|C|aI véase Figura 47.
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Figura 47. Ampliacién de regiones dentro del cromatograma, zooming.

8.9.6. Extraccion de cromatogramas. El Qualitative Analysis software abre inicialmente el cromatograma de
iones totales o TIC. Ademas permite realizar la extraccién de otro tipo de cromatograma dependiendo del
método de adquisicion utilizado. Para realizar este procedimiento, puede dar click derecho sobre el
cromatograma y seleccionar Extract Chromatograms, también puede acceder a esta opcidn a través del
menu Chromatograms disponible en la parte superior de la interface. En seguida, se abrira el cuadro de
didlogo en donde podra seleccionar el tipo de cromatograma de desea extraer, las opciones se muestran en
la Figura 48.

Nota: cuando seleccione la opcién de cromatograma de ion extraido (EIC), debe ingresar en el campo m/z
value (s) los iones m/z que desea extraer. Finalmente haga click en OK.
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8.9.7. Superposicion de cromatogramas. Para realizar la superposicion o Overlaid de los cromatogramas

Figura 48. Extraccion de cromatogramas.

seleccione en icono H2L de Ia barra de herramientas del panel de Chromatograms Results como se muestra

en la Figura 49. Si desea separarlos, haga click en el icono .Aﬁl
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Figura 49. Superposicion de cromatogramas.

8.9.8. Integracion de los picos del cromatograma. Para realizar la integracion, dar click derecho en el
cromatograma, seleccionar Integrate Chromatograms o desde el panel de Method Explorer en el campo de
(MS) en el caso de adquisicion por Scan o también puede ser utilizado

Chromatogram seleccionar Integrate



CROMATOGRAFO DE GASES ACOPLADO AL | Version: 01

6 INSTRUCTIVO DE MANEJO DEL Codigo: M-S-LC-1013

S DETECTOR SELECTIVO DE MASAS DE TRIPLE | Fecha: 14/12/2017

IDEAM &5t CUADRUPOLO AGILENT GC 7890B/QqQ 7000D | paging: 39 e 54

Integrate (MS/MS) para integrar datos adquiridos por MRM. Se abrira la caja de didlogo de/ Method Editor,
en el cual se recomienda utilizar como el tipo de integrador en el campo Integrator Selection la opcion Agile

¥ Integrate Chromatogram ~

0 Agile 2. Dar click en L , véase Figura 50.

o Para ver la tabla de resultados haga click en el menu View>Integrations Peak List, icono .

o Paraintegracién manual haga click en el icono \ﬁl

e Para quitar picos que no necesito que estén integrados. Desde el Method Explorer en la opcién
Integrate (MS) o Integrate (MS/MS), seleccione el Integrator Selection, puede ser Agile 2,y en la
ventana de Peak Filters, ajuste los eventos de integracion de modo que integre solamente sus picos
de interés. En este caso podria ajustar el parametro de la altura de los picos en el campo Filter on,
seleccionando Peak Height. Establezca el filtro segun la area relativa o absoluta (Absolute area or
Relative area).

- I{ ¢ |1 Method Editor: Integrate (MS) x

\D: Integrate Chromatogram ~| () | ) - Method ltems ~ | (= _ﬁ

} 5 Method Explorer Default m

— Chromatogram

integrator i i
||n[egrate s i g Suitablity = Peak Fiters = Results

Irtearate (MS/MS Integrator selection n
Smasth Agile 2 v

Exclude Mzss/es)

Caleculate Signal-to-Hoise

Define Chromatograms

+ Spectrum

+ General

+ Find Compounds

+ Identify Compounds

+ Compound Automation Stcps

+ Worklist Automation

+ Export

Figura 50. Integracion de areas en picos cromatograficos.

8.9.9. Eficiencia de la columna. Es posible evaluar la eficiencia de la columna a través del calculo de nimero
de platos teoricos de una determinada sustancia usando el System Suitability disponible en la caja de dialogo
del Method Edlitor.

El procedimiento consiste en abrir el archivo corrido en Full Scan con la sustancia a analizar, seleccionar
desde el panel del Method Explorer |a opcion Integrate (MS), seleccione el Integrator Selection como Agile
2 e integre el pico de interés como se explico en la Seccidn 8.9.8. Después seleccione la pestafia Suitability.
Habilitar la casilla Enable system suitability calculations. En el campo de Pharmacopeia, seleccione
United States Pharmacopeia (USP). En el campo Column void time ingrese el tiempo muerto en minutos
(min). En el campo Column Length |a longitud de la columna en centimetros (cm), véase Figura 51. Después
vaya al panel de Method Explorer>Reports>Common Reporting Options. En Templates, seleccione
System Suitability report. El reporte queda guardado en la carpeta del Data File de la muestra. Evalué el
numero de platos tedricos de acuerdo con el historial. Si se presenta un variacién aproximada del 30% del
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valor inicial, es probable que la columna esté desgastada y sea necesario cambiarla.
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Figura 51. Eficiencia de la columna, System Suitability.

8.9.10. Célculo de la relacion sefallruido. El procedimiento para calcular la relacién sefal/ruido o Signal to
noise (S/N) puede ser realizado desde el panel de Method Explorer. Desde el campo Chromatogram,
seleccione la opcion Calculate Signal-to-Noise. En seguida, se abrira la caja de dialogo del Method Editor.
En el campo Signal definition seleccione Height. En el campo de Noise definition seleccionar ASTM o
Auto-RSM. Se recomienda utilizar la opcion Auto-RMS para el célculo de S/N. Dar click en la opcién
Automatic noise region detection. En el campo Desired length ingresar el valor de 0,1 min. Véase Figura
52.
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Figura 52. Calculo de la relacion sefal/ruido.
8.9.11. Extraer espectro de masas. Es necesario realizar el andlisis en el modo de operacion de Full Scan
para obtener los espectros de masas. Desde la barra de herramientas del panel de Chromatogram Results,

dar click en el Peak Selector icono &= y seleccionar el pico de interés. Después dar click derecho sobre el
pico y seleccionar Extract Peak Spectrum, véase Figura 53.
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Figura 53. Extraer espectro de masas.

8.9.12. Extraer background del espectro. Selecciono la region del background que se desea extraer, dar click
derecho. Seleccionar Extract MS Spectrum to background. Después ir al espectro de masas dentro del
panel del MS Spectrum Results, dar click derecho y seleccionar Move to background Spectrum. En
seguida, vaya al cromatograma y extraiga el espectro de masas del pico o la region en la que desea substraer
el background. Haga click derecho sobre el espectro de masas y seleccione Substract Background, como
se muestra en la Figura 54. De esta forma el espectro estard méas limpio y libre de algunas sefiales del ruido
de fondo que afectan la identificacion del compuesto.
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Figura 54. Extraer background del espectro de masas.

8.9.13. Identificacion de compuestos. Primero se debe configurar la blisqueda con la libreria NIST 2014,
disponible en el Laboratorio de Calidad Ambiental del IDEAM. Desde el panel del Method Explorer, dar click
en el campo Identify Compunds y seleccione Search Library. Luego, se abrira la caja de dialogo del
Method Editor. En la seccion de Library seleccién, adicione la libreria dando click en el boton Add Library y
escoja la libreria NIST14, haga click en Open. Establezca como valor de Score el 80 %. En seguida en el

campo del Search Opcion

(¥} Search Library for Compoun

O dar click sobre la flecha ‘= y seleccionar la opcion

Search Library for Spectra, véase Figura 55. Por tanto, cada vez que se desee buscar el compuesto de
acuerdo con el espectro de masas, se puede dar click derecho sobre el espectro y seleccionar Search USING
NIST MS Program.
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Figura 55. Identificacion de compuestos con la libreria NIST 2014.

8.10.  Analisis cuantitativo a través del software MassHunter

El Quantitative Analysis MassHunter Version B.07.01 SP2 permite realizar la cuantificacién de un lote de
muestras a través de la creacion de un método de andlisis. Dentro de los manuales del equipo, se encuentra
disponible un DVD y la memory Stick el manual del eFamiliarization, que cuenta con los manuales con
interface gréfica muy didactica para usuarios del software Qualitative y Quantitative.

8.10.1. Para ingresar al software dar doble click en el icono disponible para MassHunter
Quantitative Analysis QQQ en el DESKTOP del computador. Alternativamente, vaya al menu de
inicio del computador Programs > Agilent > MassHunter WorkStation > QQQ Quantitative ©
Analysis.

Quantitati...

Nota: existen varias versiones del software para analisis cuantitativo, si la adquisicion de datos se realiz6 en
el modo de operacion de Full Scan o SIM, seleccionar el icono del MS Quantitative Analysis. Por otro lado, si
el andlisis fue realizado en el modo de operacion de MRM utilice el QQQ Quantitative Analysis.

8.10.2. Al comenzar el QQQ Quantitative Analysis, se abrira el programa con el disefio inicial o layout de
default que contiene las ventanas como se muestra en la Figura 56. La creacion del método de cuantificacion
es realizada en pasos sucesivos, a saber: (1) crear lote, (2) adicionar muestras, (3) verificar informacion, (4)
crear método, (5) analizar el lote y (6) correcciones y reporte. A continuacion seran descritos los
procedimientos para realizar actividades.
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8.10.3. Crear lote. Para crear un nuevo lote seleccione File > New Batch o dar click en el icono = . En
seguida busque el directorio 0 carpeta que contiene los data files del lote que desea analizar. Ingrese el
nombre del lote en el campo File name y después seleccionar el botén Open, como se muestra en la Figura

57.

8.10.4. Adicionar muestras. Seleccionar File > Add Samples. Se abrira la caja de dialogo del Add Samples.
Seleccione las muestras, calibrantes, controles, entre otros, data file que va a analizar (véase Figura 57). Use
Browse to Copy Samples para adicionar muestras de otros directorios o carpetas en este lote de anélisis,

dar click en OK.

i v R R P

Figura 56. Interface del software Quantitative Analysis MassHunter

3 e b

PRy

8.10.5. Verificar informacion. El software generaré una tabla del lote (Batch Table), con los data file a analizar

Figura 57. Creacién del lote y adicién de muestras.

Tale 4120 62 a8A| e




CROMATOGRAFO DE GASES ACOPLADO AL | Version: 01

6 INSTRUCTIVO DE MANEJO DEL Codigo: M-S-LC-1013
4

Lot o DETECTOR SELECTIVO DE MASAS DE TRIPLE | Fecha: 14/12/2017

IDEAN 85555 | CUADRUPOLO AGILENT GC 7890B/QqQ 7000D Bagina: 46 de 54

como se muestra en la Figura 58. Se debe corregir la informacion de tabla. Seleccionando los calibrantes, el
nivel del calibrante, las muestras, controles, blancos, segun el tipo de muestra.

R Agilent MassHu
File Edit View Analyze Method Update Library Report Tools Help

O & | B3 | GE AnalyzeBatch ~| @ : Layout: B B H A Reston

Batch Table
Sample: j Mix 2_5 ppb - ﬂ Sample Type: <All>
Sa
@ Nl MName Data File Type |Levd Acq. Date-Time
> Mix 2_5 ppb | Mix 2_5 ppb.Dff| Cal [+] 1 8/11/2017 235 PM
Mix5ppb | Mix5ppb.D | CallCal |2 8/11/2017 4:43 FM
Mix 10 ppb_ | Mix 10 ppb.D || Cal 3 &/11/2017 £:02 PM
Mix25ppb | Mix25ppbD [ Cal  [4 &/11/2017 715 PM
Mix 50 ppb | Mix 50 ppb.D || Cal 5 &/11/2017 225 PM
Mix 100 ppb | Mix 100 ppb.Dff| Cal 6 8/11/2017 3:42 PM

Figura 58. Tabla del lote de analisis.

8.10.6. Crear método. Seleccionar Method > New > New Method from Acquired MRM Data. Como el
método es nuevo primero se debe editar. De modo que debe seleccionar Method > Edit, véase Figura 59.

File Edit View Analyze Method | Update Library Report Tools Help e Edit View Analyze |Method | Update Library Report Tools Help
= " 1
=" N \ New 4 \é‘lNewMethDdfrDmf-\cquuedMRMDatam || | & 3| B |= New v [A
Batch Table Open » New Method from Acquired Scan Data... 1Table Open »
Sample: (4] Mix 2.5 ppl Append » New Method from Acquired Scan Data with Library Search... v B 151! imple: ] Mix 2.5 pp Append N
[ it F10 New Method from Acquired Chromatographic Data... Az = o ‘
= Edi
@ 1% | Name g visate New Method using Manual Setup T e Tl
3 2.5 ppb & Valdate
5 ppb Save New Method from File.. Wi 3 & o
10 pob o Tl 5 ppb Save
i 25 ppb : M 10 et Save As...
e50ppb |FEY Exit F11 Mix 25 ppb
e 100 ppb Mix50ppb | 1B Exit F11
Method Setup Tasks » Mix 100 ppb
Manual Setup Tasks » Method e plTte) @
Outlier Setup Tasks » Manual Setup Tasks C
Advanced Tasks D Outlier Setup Tasks »
Copy Calibration Levels To. Advanced Tasks >
Average Calibration Replicates... Copy Calibration Levels To...
Create Levels from Calibration Samples Average Calibration Replicates...
Import Calibration Levels from File... Create Levels from Calibration Samples
Import Calibration Levels from File...

Figura 59. Crear método de analisis cuantitativo por MRM.

Nota: cuando ya esta el método creado, se puede abrir el método después de crear el lote. Para esto
seleccione Method>Open>0Open Method from Existing File, como se muestra en la Figura 60.
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——
BB Agilent MessHunter Quantiatve Analhse for GOQ) - 20171003 Prevalidacion DL - 20171003 Prevaidacion DI.OCP batch bin =y x|
File Edit View Analyze [ Method ‘ Update Library Report Tools Help
N & || G| New v A Restore Default Layout
Batch Table [ open [ Open Method from Existing File.. I - x
Sample: ] Blanco Mat Append » Open Method from Existing Batch... - = 1STD: 18 E] 121 L A )
B Edit F10 Open and Apply from Existing File..,
@ | ¥ Name | e valdate JBe=Time
AceOEt 1 :50 PM
10 ppb Save 24 FM
20 ppb ve Ac :58 PM
30 ppb S 732 FM
50 ppb Ed Edit F11 B0SFPM
(| 75 ppb 38 PM
100 ppb Methed Setup Tasks » B13PM
I AceQEL 2 Manual Setup Tasks 3 P47 P
» Blanco_Matriz 0:21 PM
LDM10_Antes Outlier Setup Tasks » 10:55 FPM
LDM10 Despld gy anced Tasks y [129FM
Rec_10 2:02 AM
AceOEL 3 Copy Calibration Levels To... 2:36 AM
Average Calibration Replicates...

Figura 60. Abrir método de analisis cuantitativo.

8.10.6.1 Editar método. Desde el menu Method, seleccione Edit. En seguida se abrira la interface del médulo
de Method Task. Se realizaran las modificaciones en el panel de Method Setup Task.

e  MRM Compound Setup
Para comenzar se deben crear los compuestos. Seleccionar la pestafia del MRM Compound Setup. En
seguida vaya a la ventana del Method Table, dar click derecho y seleccionar New Compound. Registrar los
datos en la tabla correspondiente a los pardmetros del ion de cuantificacién (Quantifier), como se muestra en
la Figura 61. En el campo de Name, ingrese el nombre del compuesto. En el campo de Scan, seleccione
MRM. En el campo de Type, seleccione target. En el campo Precursor ion, seleccione el m/z del ion
precursor. En el campo de Product lon seleccione el m/z del ion producto. Recuerde que estos iones
corresponden a la transicion del ion de cuantificaciéon. En campo RT, ingrese el tiempo de retencién de cada
compuesto. Nota: cuando se esté trabajando con estandar interno (ISTD, Internal Standard) se debe incluir el
compuesto en esta tabla enel campo Type, seleccione ISTD.

[ Agilent MassHus
File Edit View

0 & H| & re Default Layout

Method Tasks | |

New / Open Mcthod Time Segment: 4  <All> ~ = | Compound: @] <4> v [@] | Reset Table View

Workflow &b

Method Setup Tasks Name Data File Tyee Level Acq. Method File | Acq. Date-Time
WM Compound Setup 1 | Mix 2_5 ppb. | Mix2 5ppbD | Cal [1 | Metode EPA MR_ [211/2017 3:35 |
i Retenti Tselup —

TS nsition Scan Type Precursor lon Product lon RT lon Polarity

2 1STD Setup
1% Concentration Setup
FE Qualifier Setup.

&7 Calibration Curve Setup

EAEACAEAES
HHEEHH

alfa
josulfan beta
[E Globals Setup ‘
——— ‘ Click derecho
& Validate
A Ny
Save Sample Information y
Save A El + @ 9 7 MS: ~ | Max # of panes: 2 - pol
e ns - e g 4;‘“ :5 :9; Restors Default Columns s Af df
=) Mix 2_5 pp!
Ed Exit g =02 Auto Fit Columns et 0}
:“::“'::“":“: 8 7, @ Fill Down
e 35 Reset Sort
Advanced Tasks
vanced Tas| 3 Arrange Compounds By »
25 [/ New Compound v
2 % New Qualifier
15
T New Calibration Level
05 W Delete Del

— Copy Calibration Levels To. —
65 7 75 & 85 3 135 14 145 15 155 16 165 17 175 18 165 19 195 20 205 21 215
Average Calibration Replicates..

Compound Information Group By Time Segment

2o 3t AZ)E H|E el
+~MRM (= ->0.0) Mix 2_5ppb.D —NO DAT, Collapse All
SXWD

=00

0.0
= «10
g oS rint. vl = 0%
2 & Print. Cerl+P ]
08 [, Print Preview. £ ¥
07 s o
Properties. =

Figura 61. Crear nuevo compuesto.
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e Retention Time Setup
El siguiente paso es editar el tiempo de la ventana de visualizacién de cada compuesto. En el panel del
Method Task, seleccionar la opcion Retention Time Setup, después desde el panel del Method Table, en el
campo RT Delta establecer una variacién de 0,5 minutos a partir tiempo de retencion para cada analito (véase
Figura 62).

[ Agilent MassHunter Quantitative Analysis (for QUQ) - Method \GCMS\Tdatalulio\Va
Help

0 E | 53 [GE AnalyzeBaich ~| i@ © Layout [T B H A Restore Default Layout
Method Tasks ~ % [Method Table

New / Open Method Time Segment. 4= <All> ~ = | Compound: [&] Clorotalonil + [ | Reset Table View
Workflow Sample

Method Setup Tasks Name Dats File Type Level Acq. Method File | Acq. Date-Time
| Mix2_5 ppb | Mix2 5ppbD [ Cal 1 | Metodo EPA MR_ [811/2017 3.35

/£ MRM Compound Setup

[ 42 Retention Time Setup |
ame ransition an vpe elta | Right RT Delta elta Uni
N s Transili S T RT Lef RT Delta | Right RT Delt RT Delta Units
=2 157D Setup Cloroialonl 2638 > 167 R arget
3 Concentration Setup Fropanil 2170 161 R arget

Clorpirifos EXESE] R arget
E Qualfier Setup Endesulfan alfa 241.0-> 205 R arget

5% Calibration Curve Setup Endosulfan beta 241.0 > 205 R arget

Quantifier

nutes
nutes
nutes
nutes
nutes

-

[ Globals Setup

‘ Save [ Exit |

Figura 62. Segmento de tiempo de retencion.

o ISTD Setup

En el caso, en que se esté realizando cuantificacién con estandar interno, se debe seleccionar el ISTD para
cada analito. Desde el panel del Method Task, seleccionar la opcién ISTD Setup. Después, vaya a la
ventana del Method Table. En el campo ISTD Compound Name, escoja el ISTD para cada analito. En el
campo de ISTD Flag, seleccione la casilla para activar el ISTD para el analito. En el campo ISTD Conc,
ingresar la concentracion del estandar interno.

Caso contrario, si no se va a utilizar el estandar interno, no se deben realizar modificaciones en esta seccion.
Un ejemplo de esta configuracion se muestra en la Figura 63.

BF Agilent MassHunter Quantitative Analysis (for GQQ) - M
File Edit View Anal
O B M| G (= AnchyzeBaich -| @ 'y [Al Restore Default Layout

Method Tasks ~ X [Method Table
New / Open Method Time Segment: 4= <All> ~ = | Compound: [# Clorotalonil v [ | Reset Table View

\GCMS\T\data\lulio\Va

Workflow Sample

Method Setup Tasks Name DataFile Type Level Acq. Method File | Acq. Date-Time
D lCal K] Lieigdo FEA B (Ra1oniy 238 |

F{ MRM Compound Setup
Retention Time Setu
I gs ISTD Setup.
3% Concentration Setup
96.9 -> 168, arget <None> )

B Qualfer Setup Endosulfan alfz 41.0-> 205 anget <None>
+# Calibration Curve Setup Endosulfan beta 41.0 -> 205. arget <None>

Transition Scan Type 1STD Compound Name | ISTD Flag | ISTD Conc. | Time Reference Flag
2638 > 167 arget <one> ] [l
17.0-> 161 arget <one> ]

57 Globals Setup

Figura 63. Configuracion del estandar interno.

e Concentration Setup

Para editar la seccion de las concentraciones de los calibrantes del método, se debe realizar en varios pasos.
Desde el panel del Method Task, seleccionar la opcion Concentration Setup. Después realice las
modificaciones desde la ventada del Method Table.

(1) En primer lugar, se deben crear los niveles de la curva de calibracion. Ir a la tabla del método y dar click
derecho sobre la region del nombre del compuesto. Posteriormente, seleccione la opcidn =1 New Calibration
Level y repita el proceso para cada nivel de la curva que desea incluir. Inmediatamente, se generara la tabla
de la calibracién. Nota: el software permite crear hasta 10 niveles de calibracion, véase Figura 64 .

(I) Después ingrese un prefijo para el nivel de la calibracion en el campo Level. Se recomienda ingresar el
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mismo dato que se incluyd en la creacion del lote (véase Figura 58). De esta forma, el software utilizara la
respuesta del area cromatografica del Data File respectivo a ese nivel para realizar la curva.

(1) En el campo Conc., ingrese la concentracion de cada uno de los niveles de la curva en orden creciente.
(IV) Desde la Tabla del Quantifier, en el campo Units, puede seleccionar las unidades de concentracién en
ng/mL, pg/L o pg/mL.

Figura 64. Concentracion de la curva de calibracion.

(V) Si las concentraciones de los niveles de calibracion de todos los analitos son las mismas, puede copiar los
datos para los demas compuestos. Vaya al menu de la ventana del Method Table, dar click derecho.
Después seleccionar Copy Calibration Levels To, en seguida seleccionar los compuestos que desea que
tengan la misma concentracién en los niveles de calibracién, dar click en OK, como se muestra en la Figura
65. Nota: si la cuantificacion es realizada con ISTD, debo adicionar el mismo nimero de niveles de la curva,
pero todos en la misma concentracion, porque el ISDT es adicionado a la muestra y a todos los niveles de la
curva en la misma cantidad.

5 Compounds (5 ol

Figura 65. Copiar los niveles de concentracion de calibracion.

e Qualifier Setup
En este paso, se deben adicionar las transiciones MRM de los iones de confirmacién para cada compuesto.
Por tanto, desde el panel del Method Task, seleccionar la opcion Qualifier Setup. En seguida vaya al panel
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de navegacion del Method Table. Seleccionar el nombre del compuesto al que va a adicionar la transicién y
dar click derecho sobre este. Posteriormente seleccionar la opcion Z New Qualifier, véase Figura 66.

En la tabla del Qualifier seleccionar las masas de los iones (m/z), de cada transicion de la reaccion. Asi,por
ejemplo, se debe seleccionar el Precursor lon y Product lon para cada transicién. En el campo de Relative
Response (Rel. Resp.) ingrese la relacién del area del ion de confirmacion (Qualifier) en porcentaje (%) en
relacién al area del ion de cuantificacién (Quantifier). En el campo de Uncertainty, ingrese el porcentaje de
incertidumbre en la relacion del area del Qualifier y Quantifier, el software establece por default un valor del
20%). Repita este procedimiento para cada uno de los analitos.

B Agilent MassHunter
File Edit View A

2 \GEMS\1\data\lulic\Va
e Method Updal eport Tools Help

0 & || Ea|(= AnahzeBaich | @ : Layout [ B BE B (A Restore Default Layout
Method Tasks « x [Method Table

New / Open Methed Time Segment: 4 <All> v ® | Compound: [@] Clorotalenil ~ [®] | Reset Table View
Workflow Sample
Method Setup Tasks Name: Data File Type Level Acq. Method File | Acq. Date-Time Add/Remove Colum
Mix 2 5 ppb Mix2 5ppbD | Cal 1 Metodo EPA MR_.|8/11/2017 335
. MRM Compound Setup [ 2 5 |2 5p = | | Metodo a0 535 | »
ifi
JiC. Retention Time Setup et
Name 5 Transition Sean Type Precursor lon Product lon
£ 1STD Setup | Clorotalenil [ [2638 51678 [MAM [Target [ 2638 16739] R Restore Default Columns
22 Concentration Scty Qualifier Auto Fit Columns. Cirl+U
L Qualifier Setup Precursor lon Product lon Transition Rel. Resp. Uncertainty | Area Sum @ Fil Down
57 Calibration Curve Setup S 2658 0] 265857310 | 30 L o |
2638]  2080|2638-»2280 | 870] 2000 [ | Reset Sort
" Globals Setup Quantifier Arrange Compounds By »
| save / Exit ] Name 5 Transition Scan Type Precursor lon Product lon 5 e oo p
P Propanil 17.0-> 161 arget 17, 1610
Validate =
& Clorpirifos 56.9-> 168 arget 6. 1688 New Qualifier
Save Endosuffan alfa 41.0 -> 205 arget 41 20539 Re New Calibration Level
. Endosulfan beta 41.0 > 205 arget 41 2059/ Re
Save fis ¥ Delete Del
B4 Exit Copy Calibration Levels To...
Manual Setup Tasks Average Calibration Replicates...
Outlier Setup Tasks Group By Time Segment
Sample Informetion
Advanced Tasks = Expand All

Figura 66. Seleccion de transicion de la reaccion del ion de confirmacion (Qualifier).

Para finalizar la creacion del método se hace la validacion. Por tanto, desde el panel del Method Task, vaya
el menl del Save/Exit y seleccione la opcion @ Validate. El software verificara que el método de
cuantificacién contenga todos los datos necesarios en los campos requeridos para ejecutarse correctamente.
Si todo esta correcto, aparecera el cuadro de didlogo en donde indica que no fueron encontrados errores,
como se muestra en la Figura 67. Por el contrario, si es detectado algun error la lista de errores aparecera en

la parte inferior debajo de la ventana de Compund Information. Guarde el método de cuantificacién en Save
as.

i —

Elases o

Los errores encontrados en la validacion del
método apareceran aqui.

Figura 67. Validacion del método de cuantificacion creado.
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8.10.7. Analizar el lote. Después de verificar y salvar el método. Se debe dar click en Exit. El programa le
preguntara si desea aplicar este método al lote. Seleccionar Analyzed>OK, véase Figura 68.

{8 Agilent MassHunter Quantitative Analysis (for QQQ) - Method - <C:\L Desktop\20170822 Curva\Q) 20170823 Cur... |- |- =0 ]
File Edit View Analyze Method Update Library Report elp

0 Ev H | B2 |GE AnalyzeBach | @  Layour R E Al Restore Default Layout
Method Tasks + % |Method Table - %
New / Open Method Time Segment: 4a  <All> + = | Compound: [&] Malation v [#] | ResetTable View
Workflow Quanifier "
Method Setup Tasks Name TS Transition Scan Type Precursor lon
1[127.0->1030 [ MRM | Target 127.0]

A MRM Compound Seiup imetoato | 1[1250>472  |MRM | Target 1250
JiC. Retention Time Setup letil paraoxen | 122991061 | MRM | Target 2293

tetil parati 2630 |=
£ 157D Sewp 5 Iml F=2 Apply Method ==
12 Concentration Setup

F Qualifier Setup
57 Calibration Curve Setup ||| <

& Globols Seiop Ssmple Information - x
— |E» t|a |I Yes Jl [t | [ Cance anes2 v D A 7

+~TIC MRM (= - ~) Mix

, Wouid you ixe to zpply this methed to the baich? .
®

& Validste 2,108 Additional batch processing afer apphying the method 4102
:
Save 8 6
") Quartitate 5
Save As N 5
| ) Integrate 4
=T | " tono :
Manual Setup Tasks ! 1
e " T x 0
Outher Setup Tasks 78 9 10 11 12 13 14 15 16 17 18 19 20 21 32 23 24 25 25 27 28 25 B
———— Acquisition Time (min)
Compound Information - x
[z]e ¢+ A= m @@= [A]EML 2|4
+~MRM (127,0-> 98.1) Mizc 5.0 127.0->981 .15 1730->99.1
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Acquisition Time (min) Acquisition Time (min)
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Figura 68. Andlisis cuantitativo del lote.

8.10.8. El software analizara el lote y retornara a la interface del panel de navegacion del Batch Table, en
donde calcular la ecuacién de la curva de calibracion y la concentracién de las muestras incluidas en el lote,
véase Figura 69. Si desea adicionar mas muestras para analizar en el lote. Vaya a File> add simple. En este

caso se debe analizar el lote de nuevo, dar click en el icono = *"%<" *| Verificar los resultados de tiempo
de retencion, relacion de area del ion de cuantificacién y el ion de confirmacion en todos los compuestos,
realizar correcciones con integracién manual del area del pico cromatégrafo cuando sea necesario, curva de
calibracién. Guarde el andlisis cuantitativo del lote antes de salir, incluso para generar el reporte, vaya File >
Save Batch.
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Figura 69. Correcciones y verificacion de resultados.

Medhes [ Malsten

8.10.9. Generacioén de reporte. Después de analizar el lote y verificar los resultados, se guardan los cambios y

se genera el reporte seleccionando Report > Generate. En seguida, se abrira el cuadro de dialogo del

Generate Editor, véase Figura 70.
[ Agient MassHunter Quan

eport | Tools Help i

File Edit View Analyze Method Update Libra
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G S

e
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Figura 70. Generar reportes en el Quantitative Analysis Software QQQ.

Seleccionar el Report Folder o carpeta donde se guardara el reporte desde el boton Browser. Luego en el
campo del Report method edite el tipo de reporte que se va a generar dando click en el boton Edit. Se abrira
una caja de didlogo como se muestra en la Figura 71. Para comenzar a establecer las caracteristicas del
reporte se debe adicionar el Template. Para esto haga click en el boton Add Template, seleccione el archivo
desde el directorio siguiendo la ruta D:\MassHunter\Report Templates\Quant\en-us\letter\Parts_Grafics. En
esta carpeta aparecen varias opciones de modelos de reporte. Se puede seleccionar el
QuantReport_ESTD_Complete. Continue configurando los demas campos del Report Method Edit.
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En el campo de Report mode seleccione Batch.

En el campo destination file, establecera el nombre de default del template, se recomienda no cambiar.
En el campo de Publish Format, seleccionar el XLSX que corresponde al formato en Excel.

En el campo de Printer, seleccionar la impresora en PDF CutePDF Writer.

En el campo Open published File dar click en la casilla para que abra el archivo después de generarlo.

Dar click en Save & Exit. En seguida retornara al cuadro del Generate Report. Seleccionar Generate report
now > OK. Esperar hasta que se genere el reporte.
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Figura 71. Editar y adicionar el modelo para crear el reporte del lote.
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